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Advance System Manager Overview Introduction This Chapter provides you with a printed version of the Advance System Manager on-line help files. It presents a description of the software functions and how to use them. The Chapter contains an extensive Glossary that will answer most questions for both new and experienced users:
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System Overview System Overview The Advance System Manager workstation software includes the following functions:



System Manager All other functions are handled through this part of the software. Use the Advance System Manager to: ! monitor the units. ! edit database tables, configure hardware, application IO, and other related tasks. ! write customized basic programs for analyzer operation. ! perform various utility functions, like Network diagnostics, Data Logger, and to launch tools such as Advance Maxum MMI emulation, Advance Optima MMI Emulation.



Advance EZChrom A stand alone program that can be launched from within the System Manager, the Advance EZChrom is a powerful new tool that is process oriented for the analyzer method development tasks, such as setting up the day to day routines. Use the Advance EZChrom functions to: ! configure applications and modify methods such as valve switching, integration events, peak and data acquisition parameter definition, and other related utilities. These activities may be, but are not necessarily, based on acquired chromatograms. ! generate stream/method online sequence definitions. ! manage chromatograms such as export, import, off-line analysis, re-integration.



About the System Manager The System Manager comprises all parts of the Advance System Manager software except Advance EZChrom. The main divisions are:



System View This is the monitoring function of the software. It requires no action on the part of the user, because this is a comprehensive overview of what is happening with any unit that is connected to the system at any given time. For a complete description of this window, see System View Window .
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Table Editor The editor is used to configure database tables, add rows to existing tables and similar activities. Many hardware modules, like the SNE and IO, are completely "plug and play" and will automatically configure themselves. In cases where this is not true, the Table Editor is used. For more information, see Tables.



Maxum Basic This powerful programming language is used to change and customize different programs that involve calculations, averages, sums, normalizations, etc. It is not functional in the first software release.



Other Utilities Some of the main features are: ! MMI Emulation. This feature, found on the Tools menu, allows you to view up to four workstations at one time on the System Manager screen, however only one live chromatogram is available at a time. In order to be effective, this feature requires a significant amount of random access memory (RAM) on the workstation computer (at least 32M, preferably 64M or more). ! Data Logger. This feature allows you to save all results of a specific application and stream into a file on a continuous basis. You select the Application, Stream, and Unit for logging, and the results are saved in a text file in the Results directory. ! Network Diagnostics. If you have concerns about an analyzer's response to the network and it's performance, this option will check certain aspects of the system. Currently there are four options available which allow you to check and view reports. See Network Diagnosis for more information.



About the Database The database consists of a set of tables. These tables provide storage, both temporary and permanent, for all inputs and outputs of the Analyzer. They also store the configuration of that Analyzer. Each table contains records (also called occurrences or rows) of data (attributes or columns) and functionality (scripts) that are associated with the attributes. When the data (attributes) change in value, the scripts cause actions to occur. Action also occurs when the system is activated and when records are created or deleted. The database can be viewed in two modes: Static and Dynamic.



General Functions Soon after the Advance System Manager software is installed and started, all the analyzers that are part of the network appear in the System View Window. The Advance Maxum Analyzers broadcast on the network on a regular basis about the status of the analyzer and other information. The System Manager listens to the broadcast and populates the System view window with all the units reported in the ALL group. However, if any particular unit is out
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of service, not powered up, or having network problems, such units do not broadcast and so do not appear in the System View. When the System Manager listens to such a broadcast from any unit and there is a change in the status, an icon showing the new status is displayed in the System View Window. In addition to the broadcast, Analyzers' status can also be updated manually or monitored on a regular basis. Real time Chromatograms are visible on the monitor, and they are recorded so that previous sections can be reviewed later. Supervisory users can use the Advance System Manager software to edit tables, edit EZChrom chromatograms, and write Basic programs.



Specific Advance Maxum Operations Some of the Advance Maxum System functions can be specified by using the System Manager software. This is especially true as it relates to the Tables and relational database. Throughout the manual, you will see references to a series of actions on the System Manager (SM), Man Machine Interface (MMI), and to EZChrom (EZC). These references will look like the following: MMI[meas][menu][setup][system]. This is a shorthand reference for navigating the database tables. These shorthand notations are similar to the following examples. Brackets [ ] indicate menu items or buttons: SM[system tables][System_Control] is shorthand for: go to the Advance System Manager, select unit of interest, click system tables, and click System_Control. MMI[meas][menu][setup][system]36 is shorthand for: go to the MMI, select MEAS, MENU, Setup, System and select item 36 in the list. EZ[file][data][import] is shorthand for: go to EZChrom, select the instrument, go to the File menu, select Data, then select import. xx in the IO shorthand references: “xx” signifies any of the following: ai, ao, di, do.



About the Interface The Advance System Manager software follows standard Windows 95 screen format and includes: ! Title Bar. Extends across the top of the window, displays the name of the software, and serves as a convenient "handle" to move the window. ! Menu Bar. Provides a drop-down set of commands. The Menu Bar changes depending on whether you are disconnected, connected, or editing.
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! Main Toolbar. Provides a shortcut to the most commonly used general commands and tools on the Menu Bar.



! Processing indicator. This status button is located to the left of the main toolbar. It is used to notify you that the System Manager is working on a blocking call. When the button is animated and colored, Advance System Manager is processing data. ! Analyzer Window. This is a child window similar to Windows Explorer and displays the Maxum Analyzer organized as different modules with options to view details in a tree view. It displays all the applications on the analyzer with detailed information of all the methods, results, tables, and basic programs underneath each of them.



! Analyzer Groups. selected groups of analyzers.



Tabbed windows that display



! System View. The tabbed window section of the Advance System Manager interface that displays all the Analyzer Group Tabs. This view is an important and useful module of the software because it graphically displays the status of each analyzer attached to the workstation on a continuous basis. ! Status Bar. The lowest part of the Advance System Manager screen is called the Status Bar, and extends horizontally across the bottom of the window. The default text on the left side of the bar is a reminder to press the F1 key for help. When the cursor moves across the various commands in the drop-down menus, a short description of the command function appears on the status bar. The right side of the status bar indicates whether the alpha characters are locked in upper case (CAP), whether the numeric key pad is in the number locked position (NUM), or whether the Scroll Lock has been pressed (SCRL).



Advance System Manager Status Bar
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Workstation Interface



System View Window This is the lower section of the Advance System Manager window. It is identified by a tab labeled “All” and any custom group tabs you add after installation. If the View menu option Float System View is selected, this window can be moved around the screen and “docked” in any convenient location similar to the toolbars. The same action can be accomplished if you place the cursor on the System View window frame, click the right mouse button, and select the option from the drop-down menu. When the window is floated, it behaves like a toolbar and can be placed within the window or elsewhere on the desktop. It can also be "docked" on either side, top or bottom of the window itself.



The System View Window can also be hidden using the Toggle System View button when performing a maintenance task, but the window is generally in view for instant status review. Icons on the window represent the analyzers and show their status. Every unit that is part of the network is represented on the All tab. Depending on the System View Style, the name of the unit and the Internet Protocol (IP) address is displayed either below the icon or beside it.
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A "quick menu" is also available in this window using the right mouse button. Position the cursor on an analyzer icon and click the right mouse button to see a menu that includes the Update Unit command.
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Context Sensitive Menus The Advance System Manager menu bar changes depending on whether any Analyzer Frame window is open. Another menu option appears when authorized users are using the Table Editor.



Menu Options - No Analyzer Window Open Main Menu The basic main menu is displayed when the Advance System Manager starts up or when no analyzer frame window is open. It shows the System, View, Tools, and Help menu options. In the main menu, you can make changes to the System View window such as adding or deleting individual analyzers and adding and deleting groups. Users with the necessary permission can use the Maxum Basic and Advance EZChrom application programs to work on files off-line. Other utilities like the Data Logger, Network Diagnostics, Backup/Download, MMI Emulation, and monitoring of all units in the group can be performed without a particular analyzer window being open.



The Advance System Manager - Main Menu



System Menu Commands - Main Menu The following topics describe the Main Menu commands. Many of these commands are also available on the Main Toolbar or the System View Toolbar.
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System Menu Commands - Main Menu



Open Connection Select this menu option or click the icon to view the Analyzer Selection dialog box. The box lists all existing units connected to the network. To connect to a specific analyzer, select the Unit Name and click the Open Connection button or double click the listing. Shortcut: Double click the Analyzer icon in the System View Window , or select a unit in the system view and click the right mouse button to bring up a drop-down menu and select connect.



Analyzer - Offline Instead of connecting to a real analyzer, you can use this function to work with tables from a database file that was saved during backup. This is the recommended procedure, because changes made off-line are not instantly written to the database. They can be saved to the file, and they can be downloaded later. You can also use this option when trying to configure a new analyzer that does not yet exist on the network.



Add Group Select the Add Group menu option to create a customized group of analyzers in addition to the All group. The dialog box that appears prompts you to type the name of the new group, then click OK. The group name typed should be unique and different (case insensitive) from any other existing group.
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The new name will appear on a tab in the System View window. As many as 32 groups can be added. The new group remains empty until you add one or more units using the Add Unit command. This option is also available by clicking the



button on the System View toolbar.



Shortcut: Click the right mouse button in the System View window frame – the area next to the tab. Select 'Add group' from the drop-down menu.



Delete Group Select the Delete Group menu option to delete a customized group of analyzers. The dialog box that appears prompts you to select the name of the group you want to delete. After selecting the group, click the Delete button. You cannot delete the 'All' group. This option is also available by clicking the



button on the System View toolbar.



Note: Deleting a custom group does not affect analyzers listed in the All group. Shortcut: Click the right mouse button in the System view window non-client area. Select 'Delete group' from the drop-down menu.



System View Style Select this option to change the appearance of the analyzer icons in the System View window. The sub-menu that appears shows the three options.



A check mark appears next to the option that is active. Select the desired style. Shortcut: Click the right mouse button anywhere in the System view window. Select 'System View Style' from the drop-down menu.



List Style



System View Window - List Style Icons
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In the List Style, small icons are aligned vertically on the left side of the window with the analyzer name and Internet Protocol (IP) address to the right of the icon. This option is also available by clicking the



button on the System View toolbar.



Small Icon Style



System View Window - Small Icon Style Using Small Icon Style, the analyzer icons are arranged horizontally across the System View window with the analyzer name and Internet Protocol (IP) address to the right of the icon. This option is also available by clicking the



button on the System View toolbar.



Large Icon Style



System View Window - Large Icon Style The Large Icon Style displays the analyzer icons arranged horizontally across the System View window with the analyzer name and Internet Protocol (IP) address shown below each icon. This option is also available by clicking the



button on the System View toolbar.



Add Unit Select this menu option to add an analyzer to the group that is selected in the System View window. The Add unit to ‘group name’ dialog box prompts you for the Unit Name, IP
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Address, and Unit Type. This option is also available by clicking the System View toolbar.



button on the



Delete Unit Click this button to gain access to the System View - Delete unit from group dialog box and delete an analyzer.



Update All Units Status Select this command to request the latest broadcast information for all units that are part of the network or click the



button on the System View Toolbar to Update All Units Status.



Unit Backup / Restore Select this command to gain access to the Analyzer Backup/ Restore dialog box where all password levels are authorized to make a backup, that is, save the analyzer database to a file. The Analyzer Frame window need not be open in order to backup the database. Select the unit from the list box, and type a name for the backup file in the File name field. If you do not specify a file extension, the system will add the default extension of .amd. Restore to the analyzer, that is, to write a file to the Maxum database, is an action that is restricted to those with Super or Configure level passwords. This is a complete download, not individual applications, and it rewrites the entire flash memory. This is an irreversible task and can crash the analyzer.



Please refer to the specific details provided with the shipped product about downloading the analyzer. The details vary from one product/version release to another.



Set Default Login Select this command to type your assigned Login name and Password. There are no minimum size requirements for the password, but alphanumeric characters are recommended. Click the Set button to complete the Login. Once you set the default login, the same parameters are used for logging into all the units. The data is stored in the registry, and the System Manager uses it every time it is running. To clear the default login, use Clear Default Login. REMINDER: Passwords are case sensitive. If you use the password BOB, then Bob or bob will not be recognized.



Clear Default Login Select this command to clear the default Login name and Password. No dialog or message box appears. As soon as the command is selected, the saved parameters are cleared. In order to do more than view the windows, you will need to set the Login again.
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Options Use this command to set three new defaults. When you check any of the following options, the system maintains this as the new default until you remove the check mark. ! Start or Stop Data Logger by default ! Do not update units at startup ! Minimize help information in Table Editor ! Prompt to save during row movement. Even if you exit the System Manager application, this selection will remain in effect until you change it.



Print Setup Select this command to gain access to the Print Setup dialog box where you may specify a printer (different from the default), a printer on the network, the paper size, and paper orientation.



Recent File Use this option to select name of a file that was opened during this or a previous session.



View Commands In the Main menu, all commands on this menu are toggle options, that is, a check mark next to the command indicates the option is “on.” By default, all toolbars and windows are checked except the Float System View. The last option allows the System View Window to be moved around the screen similar to a toolbar. Use this menu to hide the System View (window), the Main Toolbar, the System View Toolbar, the Table Editor Toolbar, and the Status Bar, as well as "float" the System View window. When a portion of a window is floated, it is detached from the framework of the window and can be moved around the window. Select the command and click to toggle (hide / display) the options.



View Menu - Main Menu and Analyzer Frame Menu
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System View This command will show or hide the lower portion of the Advance System Manager window. It is identified by a tab labeled "All" and any custom group tabs you add after installation.



Float System View Select this option to move and "dock" the System View Window like a toolbar. When the Float System View option is checked, you can click and drag the window anywhere on the screen. If the Advance System Manager is not maximized, the window can be floated outside the window on the desktop. It can be dragged to either side, top, or bottom of the window itself and "docked." That is, it will connect to that area of the window.



Tools Commands The availability of these tools changes depending on whether or not you are connected to the network.



Advance System Manager Tools Commands



MaxBasic This powerful programming language is used to change and customize different programs that involve calculations, averages, sums, normalizations, etc. Although it is visible on the Tools menu and on the Main Toolbar



, it is not functional in software release version 3.1.



In the future, the Maxum Basic option will allow you to write your own custom programs. The program will be used for both on-line and off-line processing.



EZChrom This application can be opened from within a specific application. Double click the Advance on the Application tree view to view a list of details about the EZChrom icon Advance EZChrom data for this Application. The Stream Results, Methods, On-Line Sequence, and Archive information are available for quick review. The application can also be opened as a separate launch or from the Advance System Manager Tools menu. Authorized users can select Advance EZChrom and choose from the list of applications to setup and create acquisition methods, calibrations, or other chromatogram functions using Advance EZChrom software (a customized version of EZChrom Elite software).
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Network Diagnostics If you have concerns about an analyzer's network response, select this option to run the Network Diagnostics.



MMI Select this option to view the MMI Emulation, or click the MMI button Toolbar.



on the Main



Print All Tables The Print All Tables option prints all the table information for tables that are available in the System Manager. You are prompted to select the analyzer of interest from a list of existing analyzers. System Manager connects to the analyzer, downloads the information, and prints each table sequentially.



AdvanceUtilities This option launches the AdvanceUtilities stand alone application software from within the Advance System Manager workstation software. Included in this software you will find: •



Syscon and Snecon operations



•



Data Logger



•



Database and Modbus Load and Unload



AdvanceUtilities can be run independently from the Advance System Manager and gives you the opportunity to continue running the tools in the background even when System Manager is not opened and running.



Maxum Analyzer Menu Menu - Open Connection New selections are available on the drop-down sub-menus, and an additional drop-down submenu, Window, appears on the Advance System Manager Menu bar when an analyzer window is open. Use the Window drop-down menu to arrange open windows or view a list of unit windows that are opened. The commands on this menu are similar to other Microsoft Windows applications. For example, Cascade stacks the open windows in an offset fashion so the title bar of each window is visible, and Tile sizes all windows proportionally such that an area of each window is visible.



The Advance System Manager Menu - Open Connection
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System Menu Commands - Maxum Analyzer Menu When connected to an analyzer, the System drop-down menu provides these selections. Many of these functions are also available on the Main Toolbar and the System View Toolbar.



Disconnect Select this command to disconnect from a selected Analyzer. Using the command is the same as clicking the Disconnect button



on the main toolbar.



Login as different user This selection is available when connected to an analyzer and when the Analyzer window is in focus. Use the option if a user with fewer privileges has logged in and supervisory personnel need to perform more advanced procedures.



Add/Delete Users This selection is available to supervisory personnel only. It is used to authorize new users or remove authority for others.



Clear Alarm Select this menu option to clear an alarm for a selected analyzer, or you can press the Delete key and remove the alarm. An authorized password is required to clear alarms.
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Window - Commands This sub-menu entry appears when the Advance System Manager has an analyzer window open or when editing a table. Most of the commands are similar to the standards set for all Microsoft Windows software applications. The selections available on this menu are:



Window Menu - Maxum Analyzer Menu The name(s) of open analyzer window(s) appear as the last entries on this menu. If the windows are maximized, use this menu to switch from one window to another.



New Window This option creates a duplicate of the selected unit window.



Cascade This option stacks the open windows in an offset fashion so the title bar of each window is visible.



Tile This option sizes all windows proportionally such that an area of each window is visible



Arrange Icons Arrange icons at the bottom of the client area in the main window. The icons here represent any minimized child windows and not the icons in the System View Window.



Table Editor Menu Menu - Edit The Edit sub-menu item appears on the Advance System Manager menu bar when you are working with the Table Editor. Use the commands on this drop-down menu when editing tables to undo or redo actions or add a new record (row) to the table.
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The Advance System Manager Menu - Open Connection to Network while Editing



System Commands - Edit Mode When connected to an analyzer, the System drop-down menu provides the following selections. Many of these functions are also available on the toolbars.



System Menu - Table Edit Mode This menu is similar to the Maxum Analyzer system menu, however you may not clear alarms. Three additional entries allow you to specify a Page Setup, Headers/Footers and look at a Print Preview.



Edit Menu Commands The Edit Menu appears when you open a table. The commands are available if you want to change, add or delete information in the table as well as re-query the database for updated information.
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Advance System Manager Edit Menu



Undo Select this option to revert to the previous edit and delete the most recent editing changes. Note that the table view is single record (row) locked with the analyzer database. This means that any changes made to a current record (row) are written to the database once the cursor moves off the record. As long as the cursor is moved among the fields within the record, no data is written to the database and can be undone.



Redo Select this option to recall the editing change that had been previously deleted with the Undo command. Note that the table view is single record (row) locked with the analyzer database. This means that any changes made to a current record (row) are written to the database once the cursor moves off the record. As long as the cursor is moved among the fields within the record, no data is written to the database and can be undone.



Add Record Select the Add Record command on the Edit Menu to insert a new row in a table. The Add Record dialog box appears with two fields: Application ID and ID. You must select an Application ID from the drop-down list, but the ID selection is at your discretion. Tip: IDs usually follow in numerical sequence. If the table is long, scroll to the bottom to see the last number before choosing to add a record.



Delete Record Select the Delete Record command to remove a row of data from a table. To delete a record, first select the row. Move the cursor to the leftmost column of the table ), click the left (called the row header), and when the cursor changes to a black arrow ( mouse button. The row will be highlighted in reverse video. Then select the Delete Record command from the Edit Menu. The record is displayed with strike-through marks until you update or exit the table. Delete Record cannot be restored with the Undo command. If you want to restore the record, use the Add Record command and re-type the information. Note: Records are permanently deleted from the database. When you delete a record, a dialog box will remind you that this is a permanent change and ask for confirmation to continue, but the Save Changes dialog box does not appear when you exit the Table.
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Save Changes Select the Save Changes command from the Edit Menu when you have made changes to a table record. If you are editing several records, the change is saved as soon as you click a different record. Unless saved, changes are not committed to the database, and the Table reverts to the previous settings. If you exit a Table without selecting the Save Changes command, a dialog box prompts you to save changes.



Shortcut: Click



on the Table Editor Toolbar to save changes.



Requery Table Use this selection when working in the table editor. The Requery function will refresh the database with any entries made by others since you have opened the table. Click the Requery Table button



on the Table Editor Toolbar.



View Menu In the Main menu, all commands on this menu are toggle options, that is, a check mark next to the command indicates the option is “on.” By default, all toolbars and windows are checked except the Float System View. The last option allows the System View Window to be moved around the screen similar to a toolbar. Use this menu to hide the System View (window), the Main Toolbar, the System View Toolbar, the Table Editor Toolbar, and the Status Bar, as well as "float" the System View window. When a portion of a window is floated, it is detached from the framework of the window and can be moved around the window. Select the command and click to toggle (hide / display) the options. When editing tables, the Reference Table and Table Information options also appear.



View Menu - Table Editor Mode



Window Commands - Edit Mode This menu entry appears when the Advance System Manager has an analyzer window open or when editing a table. Most of the commands are similar to the standards set for all Microsoft Windows software applications. The selections available on this menu are:
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Window Menu - Table Editor Mode When editing tables, the New Window option is not available, but the name(s) of open analyzer window(s) and table(s) are displayed.
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Toolbars About the Toolbars The Advance System Manager software contains three separate tool bars. Any toolbar can be moved around the screen and positioned where it is convenient for you.



Main Toolbar The Advance System Manager Main Toolbar can be moved so that it appears to “float” anywhere on the screen. Position the cursor on a blank area of the toolbar (not on a button), click and drag the toolbar across the screen to a different location. To restore it to the original position, double click the title bar. To restore it to the original position, double click the title bar.



The Advance System Manager Main Toolbar



System View Toolbar This toolbar appears below the main toolbar in the default view. Like the Main Toolbar, the System View Toolbar can also be moved and “floated” anywhere on the screen. Position the cursor on a blank area of the toolbar (not on a button), click and drag the toolbar across the screen to a different location. To restore it to the original position, double click on the title bar .



The Advance System Manager System View Toolbar



Table Editor Toolbar The Advance System Manager Table Editor Toolbar can be moved so that it appears to “float” anywhere on the screen. Position the cursor on a blank area of the toolbar (not on a button), click and drag the toolbar across the screen to a different location. To restore it to the original position, double click the title bar. To restore it to the original position, double click on the title bar .



The Advance System Manager Table Editor Toolbar
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How To Use the Advance System Manager Add a Group At times it is convenient to limit the number of analyzers that are monitored. Up to 32 different groups can be added to the System View Window. To create a group tab that will contain your selection of Analyzers, follow these steps:



1. Click the Add Group button



on the System View Toolbar.



2. Type the name of the new group in the New Group dialog box. The name should be unique and different (case insensitive) from all other group names. 3. Click OK. 4. Your new group appears as the next tab on the System View Window. NOTE: This new group is empty until you add Analyzers. For more information, see Add a Unit.



Add a Record If you want to add a new row (record) to a table, follow these steps: 1. In the right pane of the Analyzer Frame, double click the name of the bale you wish to edit. If you're not logged in, the Login dialog box will request user name and password.



2. When the table window appears, click the Add Record toolbar or select Add Record from the Edit menu.



button on the Table Editor



3. If necessary, type the requested primary key information in the Add Record dialog box and click OK. 4. The new record is added to the table. Make the desired modifications to other fields in this new record as needed and save the changes. You will be prompted to save the records to the database. Note: Some tables cannot be edited. If the Add Record or Delete Record menu commands are not enabled, it indicates that the action is either not permitted or must be performed in another way. For example, Advance EZChrom Tables cannot be edited in the Table Editor.
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Add a Unit If you create a new Group, it remains “unpopulated” unless individual Analyzers are added. To Add a Unit, follow these steps:



1. Click the Add Unit button



on the System View Toolbar.



2. The Add unit to dialog box appears. 3. If the analyzer is shown in the list box at the bottom of this dialog box, double click the name. This action will add the unit and close the dialog box. OR, to add a unit that is not listed: 4. Type the unit name in the Unit Name field. This name can be different from the Analyzer name. If you choose a name other than the Analyzer name, this new name will be shown with the unit display in the system view. 5. Type the Internet Protocol (IP) address in the Ip Address field. This should be a valid IP address in TCP/IP format. The IP address should be unique among all the configured analyzers including the analyzers in the 'ALL' group. Ask you Network Administrator if you do not know the IP address. 6. Click the arrow in the Unit type field and select one of the four types from the drop-down list. Maxum, Optima, and NAU units can be monitored besides the regular broadcast. Optima does not broadcast. The Maxum, Optima (through MMI emulation), and the Network Access Unit (NAU) can be edited. NOTE: The Monitoring interval can be changed for the Maxum, Optima, and NAU.



Assign Passwords Use the Add/Delete Users command on the System menu. This selection is visible only when an analyzer window is open and is in focus. Also, the login process should be completed and a user must have the highest authority level. 1. Select Add/Delete Users on the System Menu. 2. Click the Add User button. 3. Type the new Login and Password on the Database User - Add dialog box, then retype the password to verify. 4. Click the appropriate level of access. 5. Click the Add button to return to the Users Configured in the Unit dialog box. The new user is now shown in the list box.
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6. Click the Close button. 7. Any user configuration can also be changed by making the appropriate revisions and updating the configuration from the same dialog box. This authority is available only to those with a Super level password. When a login and password are defined, there are no minimum size requirements for the password, but alphanumeric characters are recommended. ALL entries in this dialog box are Case Sensitive. For example, if you set a Login name of BOB, neither Bob nor bob will be recognized at login. A manual stream step on MMI[meas][menu][operation mode][detail] will cause the Next to change to the step position in the new active sequence.



Backup/Restore Analyzer All password levels are authorized to make a backup, that is, save the analyzer database to a file. The Analyzer Frame window need not be open in order to backup the database. Backup



1. Click the button on the Main Toolbar to start the Backup / Restore, or select Unit Backup / Restore from the System drop-down menu. 2. Select the unit to be backed up or downloaded from the list in the dialog box. 3. Type or select a name for the backup file in the File name field. If you do not specify a file extension, the system will add the default extension of .amd. 4. Click the Backup the analyzer button. 5. The Backup/Restore Report dialog informs you of the backup progress through completion. Restore Once all fields are complete, click the Restore to the analyzer button to restore the analyzer, that is, to write a file to the Maxum database, is an action that is restricted to those with Super or Configure level passwords. This is a complete download, not individual applications, and it rewrites the entire flash memory. This is an irreversible task and can crash the analyzer. Please refer to the specific details provided with the shipped product about downloading the analyzer. The details vary from one product/version release to another.



Change Unit Properties The Unit Properties dialog box is the only avenue to changing the properties of an analyzer. There is only one way to open the dialog box:
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1. Select the analyzer in the System View window. 2. Click the right mouse button. 3. Select Unit Properties The dialog box provides fields where you can change any of the following: " Unit Name " P Address " Unit Type " Monitoring interval



Clear Alarm Alarms are identified in the System View window when the analyzer icon displays exclamation . An exclamation mark also appears next to the name on the Group tab marks when one of the analyzers in that group posts an alarm. A login with an authorized password is required to Clear Alarms. Warning: Be certain this is the alarm you wish to clear. The action cannot be reversed. If you are connected to the system, follow these steps to clear the alarm for the analyzer: 1. Double click the analyzer icon in the System View window. 2. Click the Alarm Log icon



on the tree view.



3. Select the Alarm from the list in the right pane. 4. Press the Delete key. 5. To clear All Alarms, place the cursor on the list of alarms in the right pane, click the right mouse button, and select "Clear All" from the drop-down menu. 6. To acknowledge an alarm, place the cursor on the specific alarm shown in the right pane, click the right mouse button, and select "acknowledge" from the drop-down menu.



Connect to an Analyzer To view specific data about an Analyzer, double click the analyzer icon in the System View Window. Another option is to place the cursor on the analyzer icon in the System View Window, click the right mouse button, and select "connect" from the drop-down menu. This action is the same as using the Menu option System → Open Connection.



Advance System Manager • 26



Another technique is to select an analyzer in the system view window and click the Open Connection button



on the Main Toolbar.



Create an Alarm In addition to the System generated alarms, you may create your own custom alarms using the AlarmHandler table. These custom alarms are triggered according to a specific condition. 1. Click the Tables Icon



in the Application Tree view .



2. Double click AlarmHandler in the right pane list of tables.** 3. Select Add Record from the Edit menu. 4. The current application_id appears by default. 5. Type an alarm_code in that field. (Numbers 900-996 are reserved for customer use.) 6. Click the Enable check box to activate the alarm. 7. Enter the alarm text that describes the alarm. 8. Select Save Changes from the Edit menu. 9. Exit the table. This alarm code can be used to trigger the occurrence of a condition either through the Limit table or through a basic program. **If you are not logged in, the Login dialog box will request user name and password.



Create or Select a Method 1. Create a New Method: EZ[file][method][new] or 2. Read Method from File: EZ[file][method][open] or



[newmethod]. [open method].



3. Import Method from Database: EZ[file][method][import] or



[import method].



A detailed discussion of Methods is available in the Advance EZChrom Release Notes.



Customize Alarms Standard, language-specific, alarm text is pre-configured in the database. The first character of the alarm text indicates the severity of the alarm:
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! indicates a fault alarm, ? indicates a warning alarm, + indicates a note (informational). Subsequent words in the alarm text contain parameters indicated by the % and a number. %1 and %2 are reserved for the application and stream. %3-%9 are specified when the alarm is posted. Standard alarms can be changed in severity, disabled, text changed, DO set, and Basic program run by adding a record in the alarmhandler in an application. Use SM[application][tables][alarmhandler][edit][add record] to add new alarms or change existing ones. Modifying an existing alarm requires knowledge of the alarm_code and parameters used for that alarm. See the Database Table Reference for a list of standard alarms. Alarm codes 900-996 may be added in the alarmhandler table for the use of limits and Basic programs. Only one parameter (%3 - identifies the record that issues the limit alarm) is used for limit alarms.



Define Peaks and Groups 1. Define peaks and groups in EZ[Method][Peaks/Groups]. 2. Known concentrations can be changed in EZChrom on the MMI[meas][menu][calibration][modify blend].



Delete a Group If a custom group tab is no longer needed, follow these steps to delete it:



1. Click the Delete Group button



on the System View Toolbar.



2. Select the group from the list box on the System View - Delete Group dialog box. 3. Click the Delete button at the bottom of the dialog box. NOTE: The All group cannot be deleted.



Delete a Record Warning: Records are permanently deleted from the database. When you delete a record, a dialog box will remind you that this is a permanent change and ask for confirmation to continue. If you click OK, the record is deleted. To delete a record in the Table Editor:
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1. Select the row by Moving the cursor to the leftmost column of the table called the ), click the left mouse header row. When the cursor changes to a black arrow ( button. The row will be highlighted in reverse video. 2. Select the Delete Record command from the Edit Menu. 3. The record is displayed with strike-through marks until you update or exit the table. Delete Record cannot be restored with the Undo command. To restore a record, use the Add Record command and re-type the data. Note: Some tables cannot be edited. If the Delete Record menu command is not enabled, it indicates that the action is either not permitted or must be performed in another way. For example, Advance EZChrom Tables cannot be edited in the Table Editor.



Delete a Unit If you wish to remove specific analyzers from a group, follow these steps:



1. Click the Delete Unit button



on the System View Toolbar.



2. Select the Unit from the list box on the Delete unit from group dialog box. 3. Click the Delete button. NOTE: Deleting a unit from a custom group does not remove it from the All group. If you delete a unit from the All group, the unit is deleted from all the group. However, any unit removed from the All group may reappear within ten minutes -- at the next broadcast.



Edit Unit Properties If a Unit Name, IP Address, or Unit Type changes, use the Unit Properties dialog box to edit them. This option is only available on the Analyzer “quick menu.” To see this menu, select the analyzer in the System View Window and click the right mouse button. The abbreviated menu will appear. To view the Unit Properties dialog box, follow these steps: 1. Select Unit Properties from the menu. 2. Click and drag across the text in the appropriate field to select it. 3. Type the new Unit Name, IP Address, or select a different unit type. 4. If necessary, you may also change the Monitoring Interval.
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Move Toolbars The Advance System Manager toolbar appears to be a single unit, but it can be separated into the Main Toolbar, System View Toolbar, and the Table Editor Toolbar. To separate or move a toolbar, follow these steps: 1. Point to a blank area of the toolbar either between or below the buttons. 2. Click and hold the left mouse button. 3. Drag the toolbar to either side or to the top or bottom to “dock” it to that area of the window, or 4. Position the toolbar so it "floats” in a location on the window that is convenient to your work. 5. To return a “floating” toolbar to the default position, double click the title bar.



Resize and Move System View Window The System View window can be moved around the screen, “docked,” or "floated" like a Toolbar. By default, it remains anchored or "docked" at the bottom of the window, but it can be anchored to either side or the top of the screen as well. To move the window, follow these steps: 1. Select Float System View from the View menu. This moves the System View window toward the top of the screen. 2. Position the cursor on the System View window title bar window, click and hold the left mouse button. 3. Drag the System View window to a desired location. If it docks in a location that is not convenient, repeat steps 1-3. In the floating mode, the window can be re-sized to a different dimension. When the window is re-docked, it takes the largest length/width depending upon the side to which it is docked. NOTE: If the Advance System Manager window is not maximized, the System View, like the toolbars, can be floated outside the window on the desktop.



Run a Stream/Method Run Once without skipping any MMI[meas][menu][setup][streams][force once] runs the selected stream/method once, then resumes where it left off.
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If the Once stream/method is not in the active sequence, this has no effect until the active sequence is changed to one that contains it. Once is removed by MMI[meas][menu][setup][sequence][set step] and MMI[meas][menu][setup][streams][resume seq]. Run the Same Stream/Method Continually MMI[meas][menu][setup][sequence][set always] sets the selected stream/method to be run always in this sequence. MMI[meas][menu][setup][streams][force always] sets the selected stream/method to be run always in all sequences. If the Alwy stream/method is not in the active sequence, this has no effect until the active sequence is changed to one that contains it. Alwy is removed by MMI[meas][menu][setup][sequence][set step] and MMI[meas][menu][setup][streams][resume seq].



Save a Method Before setting up an instrument in Advance EZChrom, configure the application hardware (detectors, temperature controllers, pressure controller, and streams). Once the hardware is configured, follow these steps to set up an instrument: 1. Start Advance EZChrom. 2. Define the analyzer (if this has not been done previously) using EZ[File][new instrument] or RightClick[new instrument]. 3. RightClick over the new instrument icon and select [configure]. 4. Type the instrument name. 5. [configure] 6. [set database] 7. Type the IP address or name under analyzer. 8. Check the connect to database, select the application, the click OK. 9. [import] to retrieve the analyzer's configuration.



See Analyzer Results The Advance System Manager software provides detailed information about each analyzer. Double click the analyzer icon in the System View Window to see a ladder outline (called tree
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view ) of the applications configured in the selected analyzer and the alarms on the analyzer. The System Tables can be viewed here as well. Double click the Application icon



to view the following sub-topics:



Tables Advance EZChrom Basic Programs SKPI Results Application IO Select the Results item in the left pane. The right pane shows the results of the application along with the stream and cycle run time information. The results view is an active link in that any new results in the database are shown in the window as they are reported in the database.



Set Alarm Limits Add a limit to place references on IO, results, and external results tables. 1. Click the Tables Icon



in the Application Tree view.



2. Double click Limit table in the right pane list of tables.* 3. Select Add Record from the Edit menu. 4. The current application_id appears by default. 5. Type a limit_id of your own choosing. 6. Click the desired limit field(s) to complete the row. 7. Select Save Changes from the Edit menu. 8. Exit the table. * If you are not logged in, the Login dialog box will request user name and password.



Set a DO or Run a Basic Program from an Alarm Define a new alarm or redefine an existing alarm in the alarmhandler table (see Customize Alarms above).
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Use Data Logger Use the Data Logger to log the results of the methods running on any analyzer in text format. This text file about a specific application, stream, and unit can be used for reports or analysis.



1. Click the AdvanceUtilities button



on the toolbar to open Advance Utilities.



2. Select the New Log Setup on the DataLogger menu. 3. Select the IP address of the analyzer from the drop-down list in the Ip Address field, and click OK. 4. Click the check box(s) of the desired applications and streams to be logged, and click the OK button. 5. The files are saved in the Results Directory under the Advance System Manager directory, for example: C:\AdvanceSystemManager\Results. The file name format is: [analyzer name]-[application number]-[stream number].txt Once set up, the Data Logger starts logging the data until the user stops it. Data Logger can be run in the background even when the System Manager is closed. When the System Manager Options “Start and Stop Data Logger by default” checkbox is selected, the Data Logger starts logging data on all units previously configured as soon as the System Manager is launched. To change or stop data logging of any unit, select Modify Log Setup.
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About Tables Advance System Manager Database Uses Advance System Manager can be used to query and edit certain key database tables, organizing them by table name. All Maxum Analyzers, NAUs, and Advance Optichrom® analyzers appear in the lower section of the window as they broadcast on the network. Many of the tables in the Advance Maxum database are not comparable to the Database Tables in the Advance Optichrom®. See Appendix 1 for a series of tables that compare Optichrom table entries to Advance Maxum table entries. Static mode is like a snapshot; the data in the view is captured at the instant of the query and does not change. The table must be re-queried by some user action to see changes that may have occurred. Dynamic Mode automatically changes the view as changes occur in the database. Most of the MMI screens and the Alarm Log and Results view in the System Manager are dynamic. Most of the system Manager table views are static. Database queries are primarily static (snapshot) with some notable exceptions. The following dynamic queries are maintained: ! Alarm Log ! Results •



MMI screens (most, but not all)



! System view (analyzer icon list at the bottom of the window). Data logging and MMI emulation are available but not a default. The system Manager is used primarily for configuration and high level monitoring of analyzers. Click the Tables Icon to view a list of the Tables typically used for day-to-day maintenance. This icon is visible in the Tree view panel when connected to the database. To view or change specific information in any table, double click one of the listed Table Names. The system prompts for a required password to open the Table Editor. The Advance System Manager software contains more than 100 tables as part of the realtime relational database that acts as the interface between the Syscon and the Sensor Near Electronics unit (SNE). The tables that are included as part of the Application data will satisfy most needs. Note: When you work in Table Editor, you have a live connection to the Analyzer. After you edit the table and Save it, changes are made to the database.



Reference Table This option is available to authorized users when working with the Table Editor. Reference Tables provide related information from the real-time database.
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A Reference Table is a table linked to the parent table. In other words, the column in the parent table is linked to a column in another table. If a column has a linked reference table, the toolbar item Reference Table is enabled when the cursor moves along the fields in the table editor window. When you click the Show Reference Table button, the linked table is shown in the bottom pane of the table editor window, or click the Reference Table button on the Main Toolbar.



System Tables Click the System Tables the right pane:



icon in the Analyzer tree view to see the following in



" analyzers within reach " names of host computers in the network that receive results " a list of printers used by the selected analyzer • all applications running on the analyzer • system AI, AO, DI, DO • System Configuration Table



Table Editor The Table Editor mode is invoked when you double click a table entry in the right panel of the main window. You are prompted for a password before the grid of the Table Editor window opens. Use the Table Editor to specify the parameters of the particular table in the database. To view the list of tables click the Tables when connected to the network.



icon in the tree view panel that displays



The Options selection on the System Menu provides a way to change the default appearance of the lower Help window in the Table Editor. To minimize the size of the Help information, go to System | Options and click the checkbox for "Minimize help information in Table Editor."



Table Information This option is available to authorized users. Use Table Information to view a description of the current table when working with the Table Editor. The option is invoked using the View drop down menu or the Table Information button



on the Table Editor toolbar.



Tables Title Bar The Title Bar of each table provides a quick reference to identify exactly what part of the application is being addressed. The following format illustrates how the title bar is organized: [IP Address] - Name of Application [AppID] - Name of Table
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If a Reference Table is open, an additional entry appears: [IP Address] - Name of Application [AppID] - Name of Table: Name of Reference Table



Table Operating Tips " Many drop-down lists are linked to other tables. For example, when the hrdwr_id or limitapp fields are selected, click the Reference Table icon tables at the same time.



to view related



" The width of table columns can be changed. Position the cursor over a dividing line in the header row. When the cursor changes to this symbol , click and drag the column either left or right.
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Configuring with System Manager Advance Maxum Configuration Many parts of the Advance System Manager (SM) are involved in configurations. To begin, start the SM software and select the analyzer of interest in the System View or connect to a local database using SM[System][Analyzer-offline]. The MMI is automatically attached to the local analyzer. To attach the MMI to another analyzer, use MMI[meas][menu][Select Analyzer]. The following paragraphs describe configuration details for specific functions.



Analyzer - Configuration The Analyzer's identification can be viewed and changed on the MMI[meas][menu][setup][system]9 & 35 or on the SM[System Tables][System_Control]. The table script will not allow duplicate analyzer, loop, or unit. An overall view of analyzers on the network and their status can be seen on the MMI[meas][menu][setup][other devices][analyzers] or on the SM (System Manager) software in the System View. Note: An Advance Maxum analyzer needs a loop, unit if it is connected to an Advance Data Hiway and uses ADH messages for Advance Optichrom® panel display, host TRT or HAE, printing, external results, or I/O. Analyzers will appear automatically in these views but can also be added manually on the MMI[meas][menu][setup][other devices][analyzers][add] or on the SM[File][add unit] dialog.



Applications - Configuration Applications are added, deleted, and changed on the SM[system tables][application]. Existing applications will appear in the tree view on the left of the SM (System Manager) window when attached to an analyzer. Settings for the following can be set in this table or on the MMI[meas][menu][operation mode] or [meas][menu][operation mode][detail]. ! autoclear of alarms ! autocalibrate available ! enable ! inservice Streams and valves (see I/O ) are added after an application is added. If an application is added in SM, it may be necessary to close the analyzers window and reconnect to it, in order to see the application in the left-hand tree view.
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Detectors - Configuration Detectors are added automatically into the Sys_hardware table when the Syscon starts up. When working with an offline database or prior to hardware addition, they are added manually on the SM[System Tables][Sys_hardware][edit][add record]. Once available in the Sys_hardware table, the detector is made available to the application and EZChrom configuration by adding an entry in SM[Application][Tables][App_detector][edit][add record]. All standard IO is created in the appxx tables. See Appendix 2, Standard IO. Advance Plus detectors can be configured automatically, when they are part of the Adapter board, or must be configured manually, when they use one of the two spare detector channels or are attached to an AI board in the backplane. The procedure for manually configuring a detector is: 1. go to SM[System Tables]{Sys_detector_cfg][edit][add record]. You must define the sysxx that comprise the detector. 2. go to SM[Application][Tables][App_detector][edit][add record]. All standard IO is created in the appxx tables. See the standard IO section.



Temperature Controllers - Configuration Temperature controllers are added automatically into the Sys_hardware table when the Syscon starts up. When working with an offline database or prior to hardware addition, they are added manually on the SM[System Tables][Sys_hardware][edit][add record]. Once available in the Sys_hardware table, the temperature controller is made available to the application and EZChrom configuration by adding an entry in SM[Application][Tables][App_tempctl][edit][add record]. All standard IO is created in the appxx tables. See Appendix 2, Standard IO. Be sure to add equilibrate and rampable information since that will control the types of temperature program events that are available.



Pressure Controllers - Configuration Pressure controllers are added automatically into the Sys_hardware table when the Syscon starts up. When working with an offline database or prior to hardware addition, they are added manually on the SM[System Tables][Sys_hardware][edit][add record]. Once available in the Sys_hardware table, the temperature controller is made available to the application and EZChrom configuration by adding an entry in SM[Application][Tables][App_pressctl][edit][add record]. All standard IO are created in the appxx tables. See Appendix 2, Standard IO. Be sure to add equilibrate information since that will control the types of pressure program events that are available.
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I/O - Configuration An application's tables of IO** are separate from the local or remote tables that maintain access to the hardware device or maintain communication with other systems (sys_di, sys_do, sys_ai, sys_ao). Local system IO is attached to the Local Syscon (CAN or SNE). Remote system IO are CAN and SNE IO attached to remote Syscons or IO on the Advance Data Hiway. In general, system IO is added first, then application IO. In IO references, "xx" signifies any of the following: ai, ao, di, do. Note: All Standard IO for detectors, temperature controllers, and pressure controllers are added and maintained automatically when app_detector, app_tempctl, and app_pressctl tables are configured. For additional information, see the following I/O paragraphs. ** Application IO (appdi, appdo, apai, appdo) Note: All Standard IO for detectors, temperature controllers, and pressure controllers are added and maintained automatically when app_detector, app_tempctl, and app_pressctl tables are configured.



Local System I/O - Configuration SNE The SNEcon reports its IO to the database when it is started. When working in an offline database or prior to hardware addition, use SM[system tables][sys_xx][edit][add record]. The database will recognize the hardware when it is added later and make the proper linkages. CAN When working in an offline database or prior to hardware addition, do the same as with SNE IO. Identify a new Can IO card to the database on the MMI[meas][menu][I/O][CAN I/O][CAN modules][add]. Note: In the IO shorthand references, "xx" signifies any of following: ai, ao, di, do.



Remote System I/O - Configuration ADH (Advance Data Hiway) All ADH IO needed by an application must be added manually. Use SM[system tables][sys_xx][edit][add record] to identify the loop, unit, slot, channel. Scanrate for inputs can be set to 5, 10, or 15 seconds. Remote CAN, SNE All remote CAN and SNE IO needed by an application must be added manually. Use SM[system tables][sys_xx][edit][add record] to identify the remote system's analyzer id and hardware id. Scanrate for inputs can be set to 5, 10, or 15 seconds.
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Application I/O - Configuration Once the system IO has been added, use the SM[application][application IO][appxx] dialogs to add the appropriate linkages from the application to the system IO. Adding records and attaching hrdwr_id linkages and limits to the appIO are supported safely here since they are not likely to change dynamically, but changing enable, value, zero, and fullscale is best done on the MMI. Keep in mind that the contents of the IO dialog boxes are static (snapshot). Monitoring and updating IO is done on the MMI[meas][menu][I/O].



Streams - Configuration Streams are added, deleted, and changed on the SM[Application][Tables][Stream]. The sample valve must be defined for the application in the SM[Application IO][appdo] table before the definition is complete (see I/O configuration). Stream purge_time is used to enforce the minimum stream flow time before acquisition delay is started. Note: when a stream is deleted, all stream/method pairs, results, and chromatograms for that stream are deleted.



Advance EZChrom Instrument - Configuration EZChrom requires that each application have an EZChrom instrument (reminder: there can be many applications per Maxum analyzer). Click Help when Advance EZChrom is open to see Release Notes for additional information. Do Not proceed until you have configured your application's hardware (detectors, temperature controllers, pressure controller, and streams). For step-by-step instructions, see How to Setup Instrument in Advance EZChrom Release Notes.



How to Setup Instrument in Advance EZChrom Before setting up an instrument in Advance EZChrom, configure the application hardware (detectors, temperature controllers, pressure controller, and streams). Once the hardware is configured, follow these steps to set up an instrument: 1. Start Advance EZChrom 2. Define the analyzer (if this has not been done previously) using EZ[File][new instrument] or RightClick[new instrument]. 3. RightClick over the new instrument icon and select [configure] 4. Type the instrument name
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5. [configure] 6. [set database] 7. Type the IP address or name under analyzer 8. Check the connect to database, select the application, the click OK 9. [Auto Configuration] to retrieve the analyzer's configuration For a more detailed discussion, click Help when Advance EZChrom is open and review the Release Notes.



Methods - Configuration There are many aspects to method development. The Advance EZChrom Release Notes have more detailed information, but the following topics in give short descriptions:



How to Create or Select a Method •



Create a New Method: EZ[file][method][new] or



[newmethod]



•



Read Method from File: EZ[file][method][open] or



•



Import Method from Database: EZ[file][method][import] or



[open method] [import method]



How to Setup Method Instruments The detector tab(s) are used to set up detectors as acquisition channels. Valve events, stream step, and balance detector events are set up under EZ[Method][instrument setup][Valves] and EZ[Method][instrument setup][Events]. Times and parameters for these events can be modified on the SM[application][tables][cycle events] or on the MMI[meas][menu][method][modify events]. Temperature and pressure programs are set up under the controller tabs. Note: If detectors, temperature controllers, or pressure controllers don't appear correct, check the application configuration in SM (System Manager) and be sure that the instrument was configured with an import from the database.



How to Define Peaks and Groups Define peaks and groups in EZ[Method][Peaks/Groups] Known concentrations can be changed in EZChrom on the MMI[meas][menu][methods][modify blend].
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How to Save a Method Save Method to File: EZ[file][method][save] or EZ[file][method][save as] or method] Save Method to Analyzer: EZ[file][method][export] or



[save



[export method]



Sequences - Configuration The Advance Maxum is a multi-application, multi-sequence, multi-method, and multi-stream system. In the Maxum there is a list of possible sequences per application (where the Advance Optichrom® used only one sequence) and a list of stream/method pairs for each sequence. Be sure the Stream setup is done before attempting to create the online sequence and sequence and before methods have been exported to the database. An application has only one active sequence at a time, and the application has a current, next, and selected stream/method. The selected option can be once or always. Each application automatically has a normal and calibration sequence. A verification sequence is a special type that returns to the process sequence at its end. The sequences can be viewed best on the MMI[meas][menu][setup][sequence] or MMI[meas][menu][operation mode][detail][go sequen].



How to Configure Sequences Create New Sequences: EZ[file][online sequence][new] or



[new online sequence]



Read Sequence from file and edit: EZ[file][online sequence][open] or sequence] then EZ[sequence][online sequence][edit] or



[open online



Import Sequence from database and edit: EZ[file][online sequence][import] or [import online sequence] then EZ [sequence][online sequence][edit] or Set Sequence Properties. EZ[Sequence][Online Sequence][Properties] is used to set the type of sequence or a stop at the end of the sequence. Save Sequence to file: EZ[file][online sequence][save] or EZ[file][online sequence][save as] or



[save online sequence]



Export Sequence to analyzer: EZ[file][online sequence][export] or [export online sequence] Export options are: Set as active sequence, or, for a calibration sequence, set as the default autocal sequence.
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Results - Configuration Results are placed automatically in the buffered_value of the result table when the SNEcon reports Results to the database. Prior to running the application, Results can be pre-configured on the SM[application][tables][result][add record]. The result_index is assigned from the peak number in EZChrom. It is best to monitor Results on the SM[application][results] or on the MMI[meas][menu][recent..][view result]. Results can be flagged for standard printed result logs or for host computer transmission by using SM[application][tables][result] and setting attributes logval and trtval (which indicate the order). Additional items under SM are host_euhi, decimal places (for reports), an AO or DO that is set from the result, and limit (see Glossary entry, Limits).



External Results The extresult table provides the mechanism to bring the following results into the application: results from Optichrom analyzers, results from remote Maxum analyzers, or results from another application on the same analyzer. Results are polled and, optionally, designated to go into the regular result table. This is especially useful when transmitting results to a Host. You can view and edit external results from SM[application][tables][extresult] or MMI [meas][menu][recent Chrom/Results][Xtrnl Result]. Scanrate can be set to 5, 10, or 15 seconds.



Printers Table - Configuration ADH and TCP Printing and ADH data logging is done through entries in the Printer table. Use SM[system tables][printer][edit][add record] or MMI[meas][menu][setup][other devices][printer][add] to identify Advance Optichrom® PCI and PI boards, TCP printers, or local serial port connected printers. For printing using ADH, use Type 1 = standard report, 2 = export format (comma delimited list). Loop and Unit are required entries (Syscon must also have a loop, unit to enable ADH communication). For TCP and local printing, the IP address and print queue (ip:queue) are required. A local printer is identified with the syscon’s IP address and port (: D for the debug port, : P for the other serial port). Use Type 3 = TCP standard report. Alarms_def and results_def designate the printer(s) to receive alarms or results/ calibration. Calibration_def designates one printer to receive calibration reports. The autolog attribute in the stream_method table and the logval attribute in the result table need to be flagged for automatic result logs. Autolog is also used to automatically print intermediate calibration reports.
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Hosts - Configuration Results transmission to an ADH Host Computer or a Maxum Modbus is designated through entries in the Host table. Use SM[system tables][host][edit][add record] or MMI[meas][menu][setup][other devices][host][add]. Loop and unit are required entries for HCIA or HCIH (Syscon must also have a loop, unit). Type indicates the format (1=HCI C01, 2=HCI C04, 3=HCIH, 4=HCIA, 5=results only, 6=Maxum Modbus). Print_def indicates printed output to the first result printer (used for debug purposes) and host_def designates the host to receive results. Anlzref is set to the receiving NAU for Maxum Modbus. Scale_factor is used for ADH only. Multiple hosts can be designated for results and individual stream’s results may be directed to different hosts by setting the hostdef in the stream_method table. The autotrt attribute in the stream_method and the trtval attribute in the result table need to be flagged for automatic result transmissions. An event 32 must be added to the program table in order for results to be transmitted to a Host on demand of the host interface card. See the next topic for instructions on configuring Maxum Modbus.



Maxum Modbus Protocol Interface The Maxum Modbus Protocol Interface provides Modus slave communication to a Host computer. Version 3.1 includes the transmission of results from Maxum and Optichrom analyzers to a Maxum NAU or other Maxum specially configured to carry on Modbus communication. Follow this basic procedure: 1. Configure Modbus slave and serial port. See Modbus Slave and Serial Port Configuration on page 45 for settings. 2. Create or use the default address map text file (see Modbus Address Map Sample lines page 45). 3. Use Advance System Manager’s Load Modbus utility (under Tools | Advance Tools | Loader | Load Modbus) to add the address map to the NAU. 4. Use Advance System Manager to add the NAU to the host table of the “sending” analyzers. Use Type 6, set anlzref to the NAU’s analyzer id. 5. Use Advance System Manager to add a loop, unit to the NAU if the NAU is going to receive results from Optichrom analyzers. 6. Use Advance System Manager to make entries in the “sending analyzer” result table to indicate which component values to send. Indicate the result values to send by placing an integer value in the trtval to indicate the result # in the address map. Special Instructions: •



Do not duplicate data in the address map. Only one address should be defined for analyzer 1, application 1, Stream 1, result 1. (This differs from the HCIH address map.)
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•



The address map must contain an ANALYZERSTATUS for every transmitting analyzer/application.



•



The address map must contain a RESULT for every transmitted component (with EUHI if required).



•



If the bad_value is > 0 there will be the normal process of setting values “bad”. Otherwise, the component values will be stored as is.



•



Release 3.0 has a limit of 5,000 addresses defined in the address map.



•



EUHI values must be greater that 1.0.



•



Addresses in the 20000s, 40000s, and 70000s all map into the same memory locations. The 2, 4, and 7 indicate the format of the data to the Honeywell DCS. Care must be taken to not overlap these registers in the Maxum address map. Addresses in the 20000s are forced to be data_type Q (swapped IEEE float). Addresses in the 70000s are forced to be R data_type(IEEE float). Addresses in the 40000s are customizable by the user. For the Honeywell DCS these will be 16-bit integer registers(data_type I, S, or E). For non-Honeywell systems, 40000s can be used for all non-bit data types(I, S, E, R, or Q). No checks will be made by the Maxum for overlapping register definitions.



•



Block read requests can be made for undefined addresses, as long as the first address in the block is defined.



Modbus slave and serial port configuration Using Advance System Manager, enter a value in the modbus_setting attribute of the System_Control table: Y:a,b,c,d where Y = serial port address a = baud rate(50, 75, 110, 134, 150, 200, 300, 600, 1200, 1800, 2400, 4800, 9600, 19200, 38400) b = parity (e,o or n) c = data bits (8 only) d = stop bits example:1:19200,n,8,1



Address Map Sample lines Some sample lines from an address map: (the first line is ignored) Ref_index,host,tag,desc,data_type,address,anlz,app,stream,res,value_type,initvalue,euhi _address 1, , , , , , , , ,sf, 9999 2, , , , , , , , , bv, 65535 3,,,B,10, ,,,,DCHG,0,1,, 4,,,B,1001,1,1,1,,SKIP,0,1,, 5,,,B,1002,2,1,1,,SKIP,0,1,, 6,,,B,1051,1,1,1,,SEL,0,1,, 7,,,B,1052,2,1,1,,SEL,0,1,, 8,,,B,1101,1,1,1,,CU,0,1,, 9,,,B,1102,2,1,1,,CU,0,1,, 10,,,B,1151,1,1,1,,ECHG,0,1,,



# scale factor #”bad value”
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11,,,B,1152,2,1,1,,ECHG,0,1,, 12,,,B,1201,1,1,1,,DCHG,0,1,, 13,,,B,1202,2,1,1,,DCHG,0,1,, 14,,,B,1351,1,1,1,,CAL,0,1,, 15,,,B,1352,2,1,1,,CAL,0,1,, 16,,,B,1667,1,1, ,,SBY,0,1,, 17,,,B,1668,2,1, ,,SBY,0,1,, 18,,,B,11001,1,1,1,,RDME,0,1,, 19,,,B,11002,2,1,1,,RDME,0,1,, 20,,,Q,20001,3,1,1,,RES,,1,, # new data_type Q and new addresses in the 20000s indicates Swapped IEEE float 21,,,S,30002,2,1,,,AN,0,1,, 22,,,S,30002,2,1,,,AN,0,1,, 23,,,S,30255,1,1,,,CY,0,1,, 24,,,S,30256,2,1,,,CY,0,1,, 25,,,S,30509,1,1,,,DED,0,1,, 26,,,S,30510,2,1,,,DED,0,1,, 27,,,S,31001,1,1,1,1,RES, ,1,,31255 # must define euhi address is no longer necessary for non-scaled results 28,,,R,40003,2,1,1,1,RES, ,1,, 30,,,S,32001,1,1,1,2,RES, ,1,,32255 31,,,S,32002,2,1,1,2,RES, ,1,,32256 32,,,E,32255,1,1,1,2,EUHI,1,, 33,,,E,32256,2,1,1,2,EUHI,1,, 34, , ,I,40033, , , , ,SCSEC,0,1,, 35, , ,I,40034, , , , ,SCMIN,0,1,, 36, , ,I,40035, , , , ,SCHR,0,1,, 37, , ,I,40036, , , , ,SCDAY,0,1,, 38, , ,I,40037, , , , ,SCMON,0,1,, 39, , ,I,40038, , , , ,SCYR,0,1,, 40, , ,I,40039, , , , ,SCDOW,0,1,, 41, , ,R,70005,3,1,2,,RES,,1,, # addresses in the 70000s are IEEE floats



Basic Events (Programs) - Configuration Only certain pre-written Basic programs are available under version 2.0, 3.0, and 3.1. Later versions will allow you to write your own Basic programs. Autocalibration is scheduled under basic events by setting the attribute pgmfunction to 1. Autoverification can be run likewise, with pgmfunction 2. Using the pgmfunction allows scheduling of these actions without a MaxBasic program. Use these Basic Events to accomplish the following: ! Schedule Programs ! Set up Parameters ! Set up External results Scheduling Programs Basic programs or pgmfunctions for an application are added in the application's program table. Programs are either:
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•



scheduled by time or frequency and having no streamcontext. These can be run from the MMI or SM, as the schedule indicates, from a limit(through the alarmhandler) or from an external request(ADH, another analyzer/application, or Modbus).



•



unscheduled and having a streamcontext. These can be run from the MMI or SM or from a cycle event or the mvrpgm attribute in the stream_method table, from a limit (through the alarmhandler) or from an external request (ADH, another analyzer/application, or Modbus).



The Program_schedule table allows programs to be scheduled by date and time, by day of month and time, by day of week and time, and by specified time interval (frequencies < 5 seconds are not allowed). A program can be scheduled multiple times in any of these ways. Use MMI[menu][setup][basic events][sched] to add, delete, or modify an application program_schedule. Attributes are as follows: schedule_time: schedule_day: freq_unit: freq_amt:



time (example, 10:00 or 16:00) 0-127 for day of week (like Optichrom) 200-231 for day of month 1=hour, 2=minute, 3=day, 6=month, 7=year how many freq_unit intervals (starts at time enabled)



Setting Up Parameters Database information can be accessed by Basic programs through the Basic DAO (Data Access Objects) or can be specified as passed arguments in the program table with corresponding parameters in the Parameters table. The program/parameter method provides stream specific passing of a limited number of database values for read-only to a Basic program at run time. Time critical information, like the value of an AI at a particular instant, may be better accessed from within the program. Parameters are added with SM[application][Parameter][edit][add record] and can be viewed/edited there and in MMI [meas][menu][setup][Parameters]. The parameter list is entered into the program table as a list of comma separated parameter_ids (in iargs, rargs). These parameter_ids need to be defined to access certain database tables and constants at program runtime (a different set may be entered per stream). By entering a Parameter value, a real or integer constant can be sent to a program. Parameters - qtype and qid The qtype is identified as follows: 1 = AAPAI 2 = APPDI 3 = BUFFERED RESULTS 4 = SAVED RESULTS 5 = EXTERNAL RESULT
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The qtype and qid (ID # OF THE ITEM) attributes in the parameter table hold query information to access individual AI, DI, buffered result, saved result, and external result values. For examples, see Multiple Use of APPAI page 92 of Appendix 2.
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Working with Applications The System Manager monitors and reports the performance of Advance Maxum applications. In many instances, applications are best monitored on the MMI or the MMI emulation of the System Manager software. Use the Results, SKPI, and Application IO entries of the System Manager to view the performance reports as described in the following topics. After these sections, you will find more detailed explanations about running and monitoring applications.



Results Click the Results icon to view the Stream ID, Result Name, Buffered Value, and Units pertaining to the Application.



SKPI Click the System Key Performance Indicator icon in the Analyzer tree to see a list of the Method-Stream indicators such as Peak Area, Retention Time, and Cycle Time to name a few. This is a read-only list for quick reference. This is not an active link in that the data does not reflect the changes made in the database after obtaining the data. At any time, you can update the information by requerying the table.



Application IO Each application has a separate set of Application IO dialog boxes. The underlying information available to these dialogs derives from the System IO Tables, and in general the Application IO is added after the system IO. The Hardware Properties section and many of the other fields on the dialogs are read-only references to the System IO tables. You may refer to these application dialogs to enable or disable the scan and review values. The dialogs are not considered active table queries. Click the Application IO icon Output dialog boxes: AI, AO, DI, and DO.



in the Analyzer tree view to see the four Input or



Authorized users can double click these entries to select the appropriate Hardware ID, Limit ID and other appropriate hardware properties. These dialog boxes accommodate the addition, deletion, and update of the various IO.



Alarms - Running or Monitoring The alarm_log table stores alarms for all applications and hardware attached to the Syscon. The Alarms can be monitored on the MMI[meas][alarms] or [meas][menu][alarms] or on the SM[alarm log]. Unacknowledged alarms with the same alarm_code and parameters (application, stream, and others) are posed only once and then counted. The time displayed is the last time that the alarm occurred. On the MMI, "**" appearing before the time indicates multiple occurrences and "+" appearing after the time indicates that this was prior to the current day. Use MMI[meas][alarms] or [meas][menu][alarms][detail] for more complete details.
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An unacknowledged fault or warning alarm on the local database during the current cycle or not related to a cycle will cause the error or maint lights to be lit on the Syscon. Only alarms that can be posted back to a cycle and stream can invalidate results. Clearing an alarm will delete it from the table. Acknowledged alarms are treated as cleared alarms, but they are left in the table. An acknowledged or cleared alarm will not cause a change in the stream or application alarm attributed to this cycle (curr_error or curr_warning in the stream table), i.e., clearing or acknowledging a fault alarm while the cycle is running will not change the fact that the results are invalid. If autoclear is set in the application table (see Application example) a cycle without faults or warnings will clear all fault and warning alarms for the current stream from previous cycles; a cycle without faults will clear all fault alarms for the current stream. ADH panel messages can be used to view and clear alarms. EZChrom offers some limited alarm handling as well. Go to EZ [Control][Application] and view the most recent alarm as a tooltip by moving mouse pointer over the application status display. Right-click on the application status display to clear the most recent or all alarms. Application control Applications are best monitored on the MMI[meas][menu][operation mode]. A disabled application cannot be run. An application that is out of service will not move results from buffered to saved status. The autoclear setting will clear alarms at the end of cycle as described under Alarms . MMI[meas][menu][operation mode][detail] gives the best view of the status of an application. [go sequen] gives the best view of the sequence. The mode (on the MMI[meas][menu][operation mode] or at the top of the MMI screen) can be one of the following: RUN - cycle in progress HOLD - not in progress after current cycle completes FLOW - waiting for the stream purge clock WAIT - waiting for pressure or temperature start to be reached LOAD - sending method to the SNE. EZChrom has application control under [Control][Application]. ADH panel messages can be used for Run/Hold/Cal of the ADH default application (MMI[meas][menu][setup][system]39).
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Calibration Each application has a calibration sequence. This can be set in the application table from SM [system tables][application][autocal_app]. To calibrate, use MMI[meas][menu][calibrate] then [run manual calibration] or [run automatic calibration]. If autocal is enabled for the application, there is an AUTO CAL button. The MAN CAL button is used to start manual calibration. Calibration reports can also be printed.



Manual Calibration Pressing the MAN CAL button places the application in hold and activates the calibration sequence screen, where buttons control of the manual calibration perform the following. RUN CAL starts the selected row in the calibration sequence and runs it continuously STOP CAL places the application in hold, reverts to the last sequence, and returns to the Operations Mode screen. VIEW RF goes to the response factors, where the calibration can be accepted. HOLD places the application in hold, allowing a new row to be selected



Auto Calibration Pressing the AUTO CAL button changes the buttons to : STOP AUTO to stop calibration and revert to running the last sequence VIEW CAL to view the calibration sequence as it runs and optionally view the response factors.



Printing Calibration Reports Calibration reporting is enabled by setting up a printer for calibration reports (see printer setup for Advance Data Hiway). The autolog attribute in the stream_method table (MMI[meas][menu][setup][streams]) allows printing of intermediate calibration reports. If a printer has been set for calibration reports, final reports will be printed whether calibration is accepted or rejected and regardless of the autolog setting. The lognow attribute or MMI button will cause a report that compares the current state of calibration with the old factors.
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Sequence Control Sequence control is very flexible. This flexibility won't be necessary on a single-process stream/single-calibration stream/single-method analyzer. An active sequence, with the exception of autocalibration or a validation sequence, runs continually unless the attribute stopatend is set to true (SM[application][tables][sequence]). A calibration sequence performing autocalibration or a validation sequence returns to the last running sequence. The active sequence of a running application has a current stream/method and a next stream/method. These can be seen on the MMI[meas][menu][operation mode][detail]. The current stream/method is always the one for the current cycle. The next stream/method indicates the next that will be sent to the SNEcon, if a stream step does not occur first. This is always the one that has an "F" as seen on [meas][menu][operation mode][detail][go sequen] or [meas][menu][setup][sequence]. The "step" stream/method is the one that will flow when a stream step occurs. In the non-active sequences, the "step" indicates the first that will run in this sequence, if it is changed to active, unless that sequence is a calibration sequence which always restarts on the first entry. The MMI[meas][menu][setup][stream] shows the current and next. Both of these screens give control to interrupt the usual sequence order in a number of ways. The following sections describe these options.



Change the Active Sequence This is a Sequence Control option. MMI[meas][menu][setup][sequence][active seq] changes the active sequence to the one being viewed. Next on the MMI[meas][menu][operation mode][detail] and MMI[meas][menu][setup][stream] will not change until a stream step occurs. A manual stream step on MMI[meas][menu][operation mode][detail] will cause the Next to change to the step position in the new active sequence.



Skip Stream/Methods Temporarily This is a Sequence Control option. MMI[meas][menu][setup][sequence][set step] changes the stream/method selected to be “step.” This may cause some stream/methods to be skipped this time only through the sequence.



Skip Stream/Methods Permanently This is a Sequence Control option. MMI[meas][menu][setup][streams][disable] will cause the selected stream/method to never run in any sequence.



Run a Stream/Method Once Without Skipping Any This is a Sequence Control option. MMI[meas][menu][setup][streams][force once] runs the selected stream/method once, then resumes where it left off.
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If the Once stream/method is not in the active sequence, this has no effect until the active sequence is changed to one that contains it. Once is removed by MMI[meas][menu][setup][sequence][set step] and MMI[meas][menu][setup][streams][resume seq].



Run the Same Stream/Method Continually This is a Sequence Control option. MMI[meas][menu][setup][sequence][set always] sets the selected stream/method to be run always in this sequence. MMI[meas][menu][setup][streams][force always] sets the selected stream/method to be run always in all sequences. If the Alwy stream/method is not in the active sequence, this has no effect until the active sequence is changed to one that contains it. Alwy is removed by MMI[meas][menu][setup][sequence][set step] and MMI[meas][menu][setup][streams][resume seq].



Remove Once or Alwy This is a Sequence Control option. Alwy and Once are removed by MMI [meas][menu][setup][sequence][set step] or MMI [meas][menu][setup][streams][resume seq].



Change the Order of Sequence Permanently This is a Sequence Control option. Import the online sequence in EZChrom, make changes, and then export to the database.



Advance Data Hiway Interface In order to communicate on the Advance Data Hiway (ADH), the Maxum analyzer must have a loop and unit. A Small subset of service panel commands are available using MMI[meas][menu][Select Analyzer]. Note: When using an Advance Optichrom to view the Maxum analyzer, the application viewed is set on the MMI[meas][menu][setup][system][default ADH application].



Printing Results/Alarms Results are printed by using Advance Data Logger on the workstation or by using Advance Data Hiway messages. The Data Logger is activated by a button on the SM toolbar. Select streams for result logging. Results will go to the file indicated and may be viewed/printed from there. See the following section on How to Use Advance Data Hiway Messages.



How to Use Advance Data Hiway Messages To use Advance Data Hiway Messages:
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1. Set up printer SM[application][tables][system tables][printer][add record]. Loop and Unit are required for ADH printers, IP address and queue(ip:queue) are required for TCP printers. - Use printer id 0, the system will assign a number. - Alarms_def indicates that all first-time occurrences of alarms are to be logged. - Results_def indicates that designated results are to be logged. - Calibration_def indicates that calibration reports are to be sent(calibration reports can be sent to only one printer). - Type 1 indicates ADH standard printed log; type 2 indicates a comma-delimited list (suitable for MS Excel) for ADH; type 3 indicates a TCP printer standard log. MMI[meas][menu][setup][other devices][printers][add] can also be used to add a printer. Non-standard result printing will be supported in Visual Basic and is not yet available 2. Designate results Indicate the order for logging with SM[application][tables][Results] attribute logval. Indicate the decimal_places to be used for formatting. This is not required for calibration reports. 3. Designate stream Activate SM[application][tables][stream_method] attribute autolog or MMI[meas][setup][streams][auto log]. By setting the hostref, individual streams can be sent to specific hosts. If hostref is not set, results will be sent to all hosts as designated in the host table. For Maxum Modbus, this allows transmission of results to multiple NAUs for redundancy. On demand printing can be done with SM[application][tables][stream_method] attribute lognow or MMI[meas][setup][streams][log now].



Transmitting Results to a Host Results are transmitted to a host computer by using these Advance Data Hiway messages or the Maxum Modbus Interface: Set up host: SM[application][tables][system tables][host][add record].
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Use host id 0, the system will assign a number. Loop and Unit are required for an ADH host. Type is: 1 for HCIA C01, 2 HCIA -C04, 3 for HCIH, 4 for HCIA, 5 for results only, and 6 for Maxum Modbus. Host_def indicates transmit results, print_def indicates printed report of the host transmission to the result printer (print_def will only be active if host_def is active). Scale factor is the scale used for type 2 and 3. MMI[meas][menu][setup][other devices][hosts][add] can also be used to add a host. Designate results SM[application][tables][Results] attribute trtval. Indicate the host_euhi for HCIH or Maxum Modbus using SM[application][tables][Results]. Designate stream SM[application][tables][stream_method] attribute autotrt or MMI[meas][setup][streams][auto trt]. By setting the hostref, individual streams can be sent to specific hosts. If hostref is not set, results will be sent to all hosts as designated in the host table. For Maxum Modbus, this allows transmission of results to multiple NAUs for redundancy. On demand transmission can be done with SM[application][tables][stream_method] attribute trtnow or MMI[meas][setup][streams]



Customizing Alarms Standard, language-specific, alarm text is pre-configured in the database. The first character of the alarm text indicates the severity of the alarm: ! indicates a fault alarm, ? indicates a warning alarm, + indicates a note (informational). Subsequent words in the alarm text contain parameters indicated by the % and a number. %1 and %2 are reserved for the application and stream. %3-%9 are specified when the alarm is posted. Standard alarms can be changed in severity, disabled, text changed, DO set, and Basic program run by adding a record in the alarmhandler in an application. Use SM[application][tables][alarmhandler][edit][add record] to add new alarms or change existing ones. Modifying an existing alarm requires knowledge of the alarm_code and parameters used for that alarm. See the Database Table Reference manual for a list of standard alarms.
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Alarm codes 900-996 may be added in the alarmhandler table for the use of limits and Basic programs. Only one parameter (%3 - identifies the record that issues the limit alarm) is used for limit alarms. By placing a dash(-) in the first character of the alarm text, the alarm is not issued, but all other actions indicated are taken.



Limits Automatic limit processing can be placed on I/O, results, and external results by adding a limit then placing a reference to it in the required table. The standard alarms for limits are: hihi alarm



=> 673 ! Database:value >limit: %3



lolo alarm



=> 674 ! Database value < limit: %3



hi alarm



=> 694 ? Database:value > limit: %3



lo alarm



=> 695 ? Database value < limit: %3



These are used when no alarmhandler alarm reference is placed in the limit table.



Create Limits Following is an example of how to Create Limits using SM[application][tables][limit][add record] :
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Note: limits are checked when the analyzer starts up or when the value changes. Setting the hihivalue and the hivalue to the same thing will not cause both to happen. Only the hihialarm handler will run. Likewise with the lolovalue and the lovalue. Setting the hihivalue and the lolovalue to the same thing will result in both occurring when the value is equal. A limit with a lolovalue of 5 and a hihivalue of 2 will result in both alarms occurring for values between 2 and 5.



End of Cycle Processing - Setting End of cycle processing is set on the MMI[meas][menu][setup][streams][more][automvr] or [autolog] or [autotrt] or SM[application][tables][stream_method] by activating attributes automvr, autolog, and autotrt. If autoclear is set in the application table, a cycle without faults or warnings will clear all fault and warning alarms for the current stream. A cycle without faults will clear all fault alarms for the current stream. By designating a program in SM[application][tables][stream_method]mvrpgm, MaxBasic program will run after the results are received.



Add a Trend - Set AO from Result To add a trend, first use the I/O configuration procedure to setup the sys_ao and appao records. In SM[application][tables][results]aoapp&&aoref designate the appao. At the end of cycle, the ao will be set. This is a change from versions 1.0 and 1.01, which only changed when the result saved_value changed.



Set a DO or Run a Basic Program from an Alarm Define a new alarm or redefine an existing alarm in the alarmhandler table (see Customizing Alarms).



Setting a DO from a Result First use the I/O configuration procedure to setup the sys_do and appdo records. In SM [application][tables][results]doapp&&doref designate the appdo. At the end of cycle, the DO will be set.



Resetting a DO Use SM [application][tables][application io][appdo] to modify the attribute auto_offtime to define a time (seconds) to use to turn off a DO after it is turned on.



Running a Basic Program at the end of the Cycle To run a Basic program at the end of a “good” cycle: set the mvrpgm attribute in SM [application][tables][stream method] to the program id.
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Setting a Valve 1. Use the MMI to set the valve manually: •



On the MEAS screen, valves appear at the bottom of the screen(above the buttons). Use the “.” and “-“ keys on the numeric keypad to scroll through the valves, then press the number on the keypad that corresponds to the valve of interest. Pressing the keypad number toggles the valve on/off. If the valve is on it appears black. Note: If the valves don’t appear at the bottom of the MEAS screen, go to MMI[meas][menu][setup][System]31 to make them viewable.



•



Go to MMI[meas][menu][I/O][Digital Output], place the selection bar over the valve of interest, then use the ON and OFF buttons.



(or)



2. Use the System Manager to manually set the valve: •



SM [application][Application IO][DO], then select the DO of interest and set the value, then Update DO



3. Use EZChrom to set a valve at a certain cycle time: •



[import method] then EZ [Method][Instrument Setup][Valves], then add or edit EZ the valve settings



Changing the cycle time for a valve event may be changed in Ezchrom or using SM[application][Tables][Cycle_Event]Start_Time or by using MMI[meas][menu][Setup][Methods][Modify Events][Modify].



Database Configuration - Moving Beginning with Version 2.0, there will be database unload/load utilities available under Advance System Tools on the workstation. These utilities build a text file from a Version 1.00, 1.01, or 2.0 database (this only saves the configuration, not the methods or sequences). This file can be edited easily (if necessary) and then loaded into another analyzer. The load utility was designed to create the database table entries in an empty database but will also attempt to do the same into a non-empty database. The following is supported: V 1.00$ V 2.0 or V 3.0, or V 3.1 V 1.01$ V 1.01 or V 2.0 or V 3.0 or V 3.1 V 2.0 $ V 2.0 or V 3.0 or V 3.1 V 3.0 $ V 3.0 or V 3.1 Additional load options include: - selecting an application to unload, and - changing the application id, or - requesting no load of sys_io.
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Starting with Version 3.0 MaxBasic programs are stored in a separate .bin file.



Inverting Peaks To invert peaks for a detector, go to SM [application][tables][app_detector] and set the invertwrite to true. It is also possible to time setting this DO within a cycle to invert specific peaks.



Printing from the Parameter Table To print a report from the parameter table, which can store large quantities of data generated from MaxBasic programs, do the following. Choose parameter streamcontexts to contain all the data to be printed together. Designate up to two header lines for the report. Create a print flag to control printing. An example parameter table:



All of these parameters have the same appcontext, streamcontext. Parameter id –1 is used for the first heading, parameter –2 is the second heading, and parameter –3 is the print flag. A print to a properly set up printer will occur when the print flag value is changed to 1. In this case, the report would look like the following:



DATA LOG ANLZ:141 Header 1 Header 2 Parameter 1 Parameter 2 Parameter 3



10-FEB-2000 15:48:03



1.23 4.56 7.89
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Hardware IDs Hardware ID - Application IO This number is similar to an IP address and identifies the IO device. The number usually is displayed in the field when a device is selected from the list at the top of the dialog box. If the device is included in the System IO tables, this number is listed on the drop-down list of this field. Click the down arrow, and select the appropriate value. The syntax of the Syscon SNE Hardware ID string is as follows: "SNE.ID"."Module type"."Location ID"."Channel type"."Channel Number" SNE ID: Least 8 bits of IP Address: Box Id * 10 + SNE Location See Appendix 3 for the Nomenclature Lists.



SNE Hardware ID Definitions Syntax: xy:a-b.c-d.e.f SNE xy = SNE number (x is box or enclosure; y is SNE #). The first box has 11, 12, 13 (10 for shared i/o). The second box has 21, 22, 23 (20 for shared i/o). a = Module type. 0 = Host



4 = DPM



1= SVCM



5 = Onboard



2 = EPC



128 = Advance



3 = PECM b = submodule type. 0 = Generic I/O



129 = ACB AO



1 = 8 Valve Controller



146 = ACB DO



2 = Pressure Controller



147 = ACB FID
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3 = Relay Controller



149 = ACB DI



4 = Temperature Controller



150 = ACB DETECTOR



5 = FID Controller



151 = ACB AI



6 = TCD Controller



155 = ACB TC3



7 = Onboard I/O



156 = ACB TC4 255 = ACB ADAPTER



c = module # d = pic # e = channel type: 1 = AI



5 = EEPROM



33 = Virtual AI



2 = AO



6 = Temperature Channel



34 = Virtual AO



3 = DI



7 = Detector



35 = Virtual DI



4 = DO



8 = Pressure Channel



36 = Virtual DO



f = channel # (board specific)



CAN Hardware ID Definitions Syntax: 0:0.a.b.c a = CAN module node # b = channel type: 1 = AI 2 = AO 3 = DI 4 = DO c = channel #
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Remote Maxum CAN Hardware ID Definitions Syntax: z-0:0.a.b.c z a b



c



indicates analyzer # = CAN module node # = channel type: 1 = AI 2 = AO 3 = DI 4 = DO = channel #



REMOTE MAXUM SNE Hardware ID Definitions Syntax: z-xy:a-b.c-d.e.f z = analyzer # xy = SNE number (x is box or enclosure; y is SNE #). The first box has 11, 12, 13 (10 for shared i/o). The second box has 21, 22, 23 (20 for shared i/o). a = Module type. 0 = Host



4 = DPM



1= SVCM



5 = Onboard



2 = EPC



128 = Advance



3 = PECM b = submodule type. 0 = Generic I/O



129 = ACB AO



1 = 8 Valve Controller



146 = ACB DO



2 = Pressure Controller



147 = ACB FID



3 = Relay Controller



149 = ACB DI



4 = Temperature Controller



150 = ACB DETECTOR



5 = FID Controller



151 = ACB AI



6 = TCD Controller



155 = ACB TC3
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7 = Onboard I/O



156 = ACB TC4 255 = ACB ADAPTER



c = module # d = pic # e = channel type: f



= channel # (board specific) 1 = AI



5 = EEPROM



33 = Virtual AI



2 = AO



6 = Temperature Channel



34 = Virtual AO



3 = DI



7 = Detector



35 = Virtual DI



4 = DO



8 = Pressure Channel



36 = Virtual DO



REMOTE ADH Hardware ID Definitions Syntax: z-a.b.c.d z = analyzer # a = loop b = unit c = slot d = channel
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Advance System Manager Dialog Boxes Unit Properties Dialog Box The Unit Properties dialog box is the only avenue to changing the properties of an analyzer. There is only one way to open the dialog box: 1. Select the analyzer in the System View window. 2. Click the right mouse button. 3. Select Unit Properties The dialog box provides fields where you can change any of the following: " Unit Name " IP Address " Unit Type " Monitoring interval



New Group Dialog Box Type the name of a new group at the insertion point, and click the OK button.



Delete Group Dialog Box Click the name of the group you wish to delete, and click the Delete button.



Add Unit to Dialog Box This dialog box appears when Add Unit is selected from the System menu or the Add Unit button is clicked on the System View toolbar. The dialog box provides fields in which you may specify the Name, IP Address, and Unit type. You may type either the name or address to identify the unit. If the unit type is Optichrom, it can be monitored but not edited. Although not recommended for general use, a Monitoring interval that is different from the broadcast interval of the Advance System Manager software can be set. This option might be used to monitor behavior for a limited period when a new analyzer is added to the system. All existing units are displayed in a list box that cannot be edited.



Unit Name When the Add unit to ‘group name’ dialog box appears, the insertion point blinks in the Unit Name field. Type the name of the analyzer you want to add to a particular group. If you do not
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know the Unit Name, type a dummy name, because you can change it at any time. Click the IP Address field and type the address.



IP Address Type the Internet Protocol (IP) address for the analyzer you wish to add. Your Network Administrator should have a list of these addresses. This is required and must be a valid IP address.



Unit Type Click the arrow in this field to view the drop-down list of unit types. There are five options: Maxum, Optichrom, Optima, NAU, and Unknown. In order to change the Monitoring interval, the Maxum, Optima, or NAU option must be the selected Unit Type.



All Existing Units This section of the Add Unit to ‘group name’ dialog box cannot be edited. It provides a list of all units, by name and IP address, that were part of the network at the time of the last broadcast.



Delete Unit from Group Dialog Box Click the Unit Name to select the unit to be deleted, and click the Delete button. CAUTION: If a Unit is deleted from the All Group, it is deleted from every other group as well. If the deleted Unit is still part of the network, it will re-appear at the next broadcast .



Analyzer Backup/ Restore Dialog box All existing units To Backup the analyzer database or Restore to the analyzer, select the particular unit name that is displayed in the list box with the IP Address.



File name Type a name for the saved database. The Advance System Manager software will add a file extension of .amd if none is included.



Click the arrow button to select a folder and file name to be downloaded. If you wish to overwrite an existing file, use this function to identify an existing file.



Security The Login and Password requested in this section of the Analyzer Backup/ Download dialog box is required only if you plan to Download to the analyzer. Authorization for this action is restricted to those who have a Super or Configure level password.
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REMINDER: Passwords are case sensitive. If you use the password BOB, then Bob or bob will not be recognized.



Backup the analyzer When the analyzer name and address have been selected and the save file is named, click this button to backup the analyzer database to a file.



Restore to the analyzer When the analyzer name and address have been selected and the Login and Password entered if required, click this button to transfer the database records from the Workstation files to the Analyzer. This is a complete download, not individual applications, and it rewrites the complete flash memory. This is an irreversible task and can crash the analyzer.



Please refer to the specific details provided with the shipped product about downloading the analyzer. The details vary from one product/version release to another.



Database Login Dialog Box Use the same login for all units Click this check box to avoid having to re-affirm your Login name and Password each time you open a data table. This option only uses the parameters for that run of the System Manager. Be sure to Clear Default Login on the System menu when work is complete, because this authorization authorizes privileges for all other units as well. If you want to save the parameters through different runs of the System Manager, use Set Default Login .



Unit network Diagnostics Dialog Box This dialog box provides the following options to select in order to analyze and determine the statistics and reports required for a unit:



Ping Statistics The Ping procedure sends a request to the selected analyzer and, if a reply is received, checks the message for the correct information and calculates the round trip time taken by the message to travel to the unit and come back. This measure is an indication of how slow the network is and whether the unit is responding to the network messages. The checkbox is selected by default. Click to clear the check box if you do not want a Ping check.



Routing Table The Routing Table procedure identifies the various routers between the selected analyzer and the host. The checkbox is selected by default. Click to clear the check box if you do not want a Routing Table.
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Per Protocol Statistics The Per Protocol Statistics checks and records details of any problems that occur in data transmission. The checkbox is selected by default. Click to clear the check box if you do not want a Protocol Statistics report.



Connection List This report will show all units currently connected to the particular unit. The checkbox is elected by default. Click to clear the check box if you do not want a Connection List report.



Application IO Dialog Boxes There are four Application IO dialog boxes: Application AI, Application AO, Application DI, and Application DO. Many of the fields and buttons are common to all four. The individual fields are defined in the section following the graphical representations of the four dialogs.
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Application AI Dialog Box Use the Application AI dialog box to select the AI and associated hardware properties.



Application AI Dialog Box



Advance System Manager • 68



Application AO Use the Application AO dialog box to select the AO and associated hardware properties.



Application AO Dialog Box
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Application DI Use the Application DI dialog box to select the DI and associated hardware properties.



Application DI Dialog Box
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Application DO Use the Application DO dialog box to select the DO and associated hardware properties.



Application DO Dialog Box



Application IO Devices This first area on all the IO dialog boxes displays the ID, Name, and Type of existing IO devices. If the System IO tables are set up, all applicable settings for the analyzer become available here. Click the ID number and the related properties will be displayed in both Properties sections of the dialog. When the list exceeds the display area, use the scroll bar. You can also click the title buttons at the top of the list to sort items forward or backward by Id number.



ID This read-only field is used to display the ID number of the selected device. If the IO is shown in the list of existing devices, click the ID number in the list display area and information will be added to the appropriate fields. To add a new number, click the Add New button at the bottom of the dialog box. A smaller dialog prompts you for the New ID and Name that will be associated with another device.
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When adding a new IO, scan the list of existing names and numbers that are displayed in the list of existing devices. It is advisable to use the next number in sequence. The ID number should be unique.



Name This field displays the name of the selected device. The field is can be edited, but this is generally unnecessary. To change the name of the device, click and drag across this field and type a new name, then click the Update button. The new name will appear in the list at the top of the dialog.



Hardware ID This number is similar to an IP address and identifies the IO device. The number usually is displayed in the field when a device is selected from the list at the top of the dialog box. If the device is included in the System IO tables, this number is listed on the drop-down list of this field. Click the down arrow, and select the appropriate value. The syntax of the Syscon SNE Hardware ID string is as follows: "SNE.ID"."Module type"."Location ID"."Channel type"."Channel Number" SNE ID: Least 8 bits of IP Address: Box ID * 10 + SNE Location



Limit ID Use this field to specify a Limit that applies to the particular IO. Limits must be configured in the Limit Table prior to specifying the number in the Application IO dialog box. Once established, click the down arrow in this field and select the desired value from the drop-down list.



Value Click the down arrow in and select the desired option (1, 0, or NULL). This is typically used for reading the current value in the database.



Unit Specifies the unit of measurement for the selected device such as psig, degrees C, percent (%), and volts.
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Auto Offtime (in secs) Type the number of seconds in this field if the digital output/input is set to 1 (On) and you want to change the value to 0 (Off) after a period of time. The time you enter indicates the number of seconds before the digital output/input will be turned off.



Enable Check Box Click this box to instruct the system to scan the device. If the system encounters an error, it will disable this configuration (clear the check box). If you wish to manually stop the functionality of the device, click the box to remove the check mark.



Zero Type a value in this field to specify the percentage value of the analog IO response which corresponds to a zero value.



Full Scale Type a value in this field to specify the value of the analog IO response which corresponds to 100%.



Minimum Choices for this digital IO field are ON or OFF. If you wish to set Minimum limits, type ON.



Maximum Choices for this digital IO field are ON or OFF. If you wish to set Maximum limits, type ON.



IP This read-only field displays the network address of the device. The information comes from the System IO tables. See Hardware IO for details.



Module Type This read-only field displays the type of device, for example, SVCM. The information comes from the System IO tables.



Module No. This read-only field displays the corresponding number of the selected device as determined in the System IO tables.
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Channel Type This read-only field verifies the type of channel, such as AO and DO. The information comes from the System IO tables.



Channel No. This read-only field displays the channel number of the selected device. The information comes from the System IO tables.



Status This read-only field displays the status of the device, such as Normal.



Exclusive Check Box If this device is used exclusively for this application, a check mark is displayed. If the device is shared by other applications, the check box should be clear. The determination of Exclusive status is made in the System IO tables.



Scan Enable Check Box - Application Input Devices This box is checked if the System IO tables are configured to scan the unit on a regular basis.



Rampable This read-only check box is for information only. It is set when you configure the method in Advance EZChrom and is used for ramping a temperature controller in the Maxum GC. Click the check box in the System IO tables to instruct the system to ramp the temperature. Ramping temperature is used on program temperature GC or simulated distillation applications.



Data Type Typically this read-only field displays a range of values in the type of data that the devices will read.



Fraction of F/S This read-only field displays the current value as a fraction of the full scale.



Value This read-only field displays the actual value of the analog output/input.



Scan Rate (secs) This read-only field displays the rate at which the database scans this IO device.
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Module ID This read-only field displays the first three digits of the Hardware Id which is designated as the Module ID.



Pic ID This read-only field displays the PIC setting selected in the System IO tables.



Add New Click this button on any of the four AppIO dialog boxes when you wish to add information about a new IO device. New devices added here apply to this application only. When you click the Add New button, a small dialog box prompts you for the New ID and New Name. Type the required information and click the Add button. The new device is added to the list at the top of the dialog and to the Id and Name fields, but no hardware is attached to this new IO, and the hardware ID value will be set to NULL. You will have to select an available hardware from the list or add a new hardware IO in the SYSIO tables.



Delete Click button on any of the four AppIO dialog boxes to delete an existing IO displayed in the list box at the top of the Application IO dialog. First, select the Id number in the list box, then click the Delete IO button. If the device is not bound by a referential integrity constraint, it can be deleted. The device listing is deleted from this application only.



Update Click this button on any of the four Application IO dialog boxes to preserve the changes made to any of the fields that can be edited. If, for instance, you change the Value field, and Close or exit the dialog without first clicking the Update button, the system will prompt you that "All changes will be discarded." To save the changes, click the No button on the message box and click the Update button. Then close the dialog.



Close This button is located on all four of the Application IO dialog boxes. Click the Close button to exit the dialog box. If changes have been made and not updated, a message box prompts you that "All changes will be discarded." You have an option to return to the dialog before exiting.
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Advance Tools AdvanceTools can be run independently from the Advance System Manager and gives you the opportunity to continue running the tools in the background even when System Manager is not opened and running. Use the Tools for all the functions of Data Logger and Loader.



About Data Logger Use the Data Logger to log the Stream cycle results of any analyzer -- recorded in text format. These text files about specific applications, stream, and units can be printed and used for reports or analysis. You can open the AdvanceTools to use the Data Logger in any of the following ways: ! Click the Data Logger button on the System Manager Main Toolbar. ! Select Data Logger from the System Manager Tools Menu. ! Click the Start Button | Programs | Advance System Tools | Advance Tools. Once AdvanceTools is open, click Data Logger on the menu and select from the drop-down options.



New Log Setup Select this option to set up a new log. The Log Setup dialog box displays a list of the existing analyzers on the network. This analyzer list is composed of the list of Maxum units in the System View of the System Manager. Select the desired analyzer, and click OK. If the desired analyzer is not available in the list, use the Add Unit feature of the Advance System Manager. Units that are added while AdvanceUtilities is open are immediately available in this dialog. The Log Setup dialog is color coded. Files can be selected for logging here, but active or preset files cannot be disable from this dialog (see Modify Log Setup). If a row is gray, it indicates that the file is set up for logging. The dialog shows the following columns: ! Enable: click the check box to log this If you want to log these stream results. ! Application and Stream: these two columns are color coded and cannot be edited. ! Log File: The file name indicate the name of the log file and can be changed by the user. The default name has the format: AnalyzerName_ApplicationID_StreamID.txt. Note that all the files will be saved by default in the Results directory of the Advance System Manager.



Modify Log Setup The DataLogger Modify Settings dialog shows the list of previously Configured Logs that were configured using New Log Setup. Click one of the entries in this list to modify any of the properties associated with that log. The name of the selected log file is displayed in the file name box. Note that all the files will be saved by default in the Results directory of the Advance System Manager.
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By default the first four check boxes in the Results section are checked. Click to enable or disable these options as well as those listed in the Others section with the exception of the Result Index. This box must remain checked. Once you have made your selections, click the Modify button to store these changes. You can also specify the range of peaks that needs to be logged. By default, all peaks associated with that stream and application are logged. You can enable or disable any of them for logging purposes. To remove a log file from the list of Configured Logs, click the desired application in the Configured Logs field, and click the Delete button.



Open LogData File When Open LogData File is selected, the Open dialog appears. The default directory for these .txt files is the Results directory. Select the file name, and click the Open button. This action opens the text file in a grid form where you can view, modify, or print the file. All columns can be sorted in ascending or descending order by clicking on the columns. The data can also be saved to another file after necessary modifications.



Start DataLogger Once a Log File is set up and modified (if needed), select Start DataLogger from the menu to begin logging the data. This action starts the Server and logs all the data from all configured application-stream sets. If you want to start a single analyzer-application-stream log, do a right mouse click on the analyzer-application-stream icon in the data logger view and select the “Start Logging” from the drop-down menu. The icon show a pencil overlaid on the unit to indicate that logging is performed on that analyzer-application-stream set. The server makes a request to each analyzer database to inform the end of cycle event of that application-stream set. On receiving a report from the database, the server queries the database about the results and logs them to a file using a tab de-limited format. You can stop the action by selecting Stop DataLogger from the menu.



Stop DataLogger Select this option to shut down the logger. Note that all the logs currently enabled will be stopped. If you want to stop a single analyzer-application-stream log, do a right mouse click on the analyzer-application-stream icon in the data logger view and select the “Start Logging” from the drop-down menu. The icon will not show a pencil overlaid on the unit to indicate that logging is no longer performed on that analyzer-application-stream set. To run the data logger in the background, close the application without stopping the data logger. The application displays a prompt that asks if you want to run DataLogger in the background. Select 'Yes' and the data logger will run in the background. The icon is minimized and can be seen in the right hand corner of the task bar. To restore the application, click the icon, and the application returns to the foreground.
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Show Server Log Select this option to view the start and end DataLogging date and times as well as any other server activity. This is not the Data Log, rather it documents server action and any problems. Any problems in logging and network will be entered in the server log file with information on the problem and time at which it occurred. This file gives a good overview of the analyzer access to the network.



About Loader The Loader tool is designed to facilitate data transfer or edit some configurations of data. You can copy configuration data from one analyzer to another as well as copy data from one version of the Advance Maxum database to another (version 1.0, 1.01, and 2.0). Click Loader on the menu and select from the drop-down options.



Database Load This option normally loads data from a text file to an empty database. If the database is not empty and any conflict in the primary key information of the tables involved will result in errors, the data will not be copied over. The function is best used for data transfer between two analyzers and/or during upgrades of database versions. For example, use it to copy configuration data from one analyzer to another analyzer or to copy from one database version to another (1.0, 1.01, or 2.0). Although the message box has a Cancel option, it isn't advisable to stop this action. If you need to use the Database Load function, it is advisable to call Applied Automation, Inc. for assistance before you begin the process. All relational database requirements must be satisfied for a successful Load or Unload. Once the database is transferred, a message box appears that provides an opportunity to view the log file.



Database Unload This option "unloads" data to a text file that can be edited. It gets configuration data including hardware configuration and application configurations, but it does not get EZChrom methods or sequences. Errors are not common in the Unload option. Although the message box has a Cancel option, it isn't advisable to stop this action. This utility is useful when you copy the configuration information from one analyzer to another analyzer, assuming the hardware matches from one to another. Once the database is transferred, a message box appears that provides an opportunity to view the log file which shows you any errors encountered in the process. The unloaded text file has complete information pertaining to the hardware configuration. You can edit the information to match the new analyzer database required, (for example, change all instances of run1 to run2), but it is strongly advised that you contact the Applied



Advance System Manager • 78



Automation Support before doing so. All relational database requirements must be satisfied for a successful Load or Unload.



Modbus Load This option loads the modbus address maps from a text file into the analyzer database. If the database is not empty and any conflict in the primary key information of the modbus_addressmap table involved will result in errors and the data will not be copied over.



Modbus Unload This option "unloads" modbus address map data to a text file that can be edited. Errors are not common in the Unload option.



Load MMI language files This function helps you dynamically change the database text that is used for MMI and alarms to a different language and/or any new alarm text changes. When you select this option and specify the IP address, this function displays the Browse for Folder dialog to locate specific files for language support. Select the directory that contains the file from the "tree" view. The files should be in a highly structured format and should follow all relational database requirements. As the text is loading, the message box has a Cancel option, but it isn't advisable to stop this action. If you need to use the Text load function, it is advisable to obtain the files needed from Applied Automation, Inc.



Load DB Options This dialog box is found by selecting Database Load from the Loader menu. A caution note reminds you to make sure that all SNEs are in hold before proceeding. Click the Yes button, and select the IP address of the analyzer on the Database Load dialog. Next, click the arrow button (to the right of the File name field) to locate the .txt file. Login with your name and password before you click OK. The Load DB Options dialog box provides the following: • Delete existing applications first. Click this box if you want to delete any existing applications in the analyzer database before loading the text file. • Applications to be loaded. If you wish to select only specific applications from the text file to be loaded, specify the application ID’s of the applications you want to load separated by a comma. This will load a specific applications rather than All (represented by a zero), which is the default. • New app numbers to assign. If you want to have a new numbering sequence for the application ID’s rather than the default ones in the text file, type these numbers in the field. If you want the default ones in the text file, enter 0.
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• Skip all SYS_IO and SYS_HARDWARE. Click this box if you want to skip loading of all IO information.



The View Menu The options on this menu are similar to those of Advance System Manager. • Toolbar. Select this option to hide or display the AdvanceUtilities toolbar. • Status Bar. Select this option to hide or display the AdvanceUtilities Status Bar at the bottom of the window. • Datalogger Bar. This command is similar to the System View command in Advance System Manager. The default check mark assures that units attached to the network are displayed in this section of AdvanceUtilities. If unchecked, the Datalogger View is hidden. • Float Datalogger View. Like the Float System View command, when this option is selected the Datalogger Bar is no longer anchored to the AdvanceUtilities window and can be moved around the screen, resized, or docked in another section of the window. Note, however, that the DataLogger View cannot be floated outside the AdvanceUtilities window.



Syscon Commands on Tools Menu The options for this Tools Menu command have different results but common procedures. When you select any of the following options on the sub-menu, you receive: • A caution message to assure that SNEs are on hold or to remind you that unsaved data may be lost. • The IP Address Selection dialog box with a list of units. • The Login dialog box.



Software Upgrade Use this option to replace the Syscon software with a newer version. You can upgrade the BIOS or OS or Database or ALL. Please refer to the procedure before you using this feature as it may corrupt the flash disk of the analyzer. All applications and SNE's should be in hold before continuing with any software upgrades to SNE or SYSCON. If you are upgrading "ALL" software or Database (DB) software on SYSCON, make sure that current methods/sequences are saved to Advance EZChrom and all DB entries have been saved to Advance Utilities with a Database Unload. If you are upgrading Operating System (OS) or BIOS software on SYSCON make sure that any DB entries have been saved to FLASH before proceeding. Path: Tools | Syscon | Software Upgrade



Advance System Manager • 80



Warm Start Use this option to re-start the analyzer using the data in the battery backed up RAM if it is valid. Any changes made to the data or methods after the last ‘save into flash’ will not be lost. It is advised to keep all the applications and SNE’s be in hold before resetting the analyzer. Path: Tools | Syscon | Warm Start



Cold Start Use this option to re-start the analyzer from the flash disk. Any changes made to the data or methods after the last ‘save into flash’ will be lost. It is advised to keep all the applications and SNE’s should be in hold before resetting the analyzer. Path: Tools | Syscon | Cold Start



Set/Reset Options Use this option to set or reset different options of the analyzer. Path: Tools | Syscon | Set/Reset Options Flash Update: Disabling the flash update will override the periodic automatic database save interval specified in the database. When Flash Update is disabled there will be no automatic data base saves. Enabling Flash Update will allow the periodic automatic database save to occur at the conclusion of the next interval. BOOTP: Disabling BOOTP will result in the analyzer not broadcasting a request for configuration information on each reset. Normally BOOTP should be disabled if there is no BOOTP server on the network. BOOTP can also be disabled when the local configuration has been modified to keep the analyzer from getting new values from a BOOTP server. Disabling BOOTP will decrease the time spent on a reset, especially if there is no BOOTP server. Auto Start: When autostart is disabled, the analyzer boots to a shell prompt only. The database and display manager are not started. In this mode diagnostic commands can be typed in the shell or telnet can be used to connect to the analyzer and issue diagnostic commands. Hold Analyzer: This is a special analyzer state that is entered automatically following an operating system upgrade. When the analyzer is in this state it is safe to reload the database files for an upgrade. When run state is enabled, the analyzer will begin to process the current database stored in the flash disk.



Analyzer Reset Use this option to reset the selected analyzer. It is equivalent to pushing the reset button on the analyzer and to reset all the hardware. Path: Tools | Syscon | Analyzer Reset
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Snecon Commands on Tools Menu The options for this Tools Menu command have different results but common procedures. When you select any of the following options on the sub-menu, you receive: • A caution message to assure that SNEs are on hold. • The IP Address Selection dialog box with a list of units. • The Login dialog box.



OS Upgrade Use this option to replace the Snecon OS software with a newer version. Please refer to the procedure before you using this feature. All application and SNE's should be in hold before any software loads to SNE or SYSCON. Path: Tools | Snecon | OS Upgrade



Application Upgrade Use this option to replace the Snecon Application software with a newer version. Please refer to the procedure before you using this feature. All application and SNE's should be in hold before any software loads to SNE or SYSCON. Path: Tools | Snecon | Application Upgrade
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Glossary Advance Plus An Advance Plus system is an Optichrom analyzer with an Advance Plus door (Maxum MMI, database, and SNEcon).



Application An application can be compared with an Advance Optichrom® analyzer. Each application has the following: ! Streams ! I/O ! Active Stream Sequence ! Multiple Methods ! Basic Events ! Chromatograms ! Temperature and Pressure Control ! Results Applications on a Maxum Analyzer share hardware and a sample system. Analyzers will be configured for a certain number of enabled applications. An EZChrom instrument is attached to a single application.



Basic Programs Click the Basic Programs icon in the Analyzer tree view to view the Maxum Basic calculation routines that have been created. This powerful programming language is used to change and customize different programs that involve calculations, averages, sums, normalizations, etc. It is not functional in the version 3.1 software release. In the future, the Maxum Basic option will allow you to write your own custom programs. The program will be used for both on-line and off-line processing.



Broadcast All units on the system are monitored, and every ten to fifteen minutes the system sends (broadcasts) a status report to all units connected to the network. Changes in unit status are displayed in the System View Window each time a new report is broadcast.
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Dynamic View When the data from a database query changes automatically as changes occur in the database, it is termed dynamic. Most of the MMI screens, the Alarm Log, and Results view in the System Manager are dynamic.



Insertion Point The blinking vertical bar that appears in a field waiting for information to be typed. The insertion point can be moved by clicking in a different field.



Limits Automatic limit processing can be placed on I/O, results, and external results by adding a limit then placing a reference to it in the required table. The standard alarms for limits are: hihi alarm lolo alarm hi alarm lo alarm



=> 673 ! Database:value >limit: %3 => 674 ! Database value < limit: %3 => 694 ? Database:value > limit: %3 => 695 ? Database value < limit: %3



These are used when no alarmhandler alarm reference is placed in the limit table.



Man-Machine Interface The Man-Machine Interface (MMI) for application monitoring and control is the display software for the Advance Maxum that runs on the Syscon or the workstation. Like the System Manager, it gives a view of certain key database tables. It differs from the System Manager by organizing the views by function, rather than table name, and by using mostly dynamic queries. It is the most powerful operations and monitoring tool for the Analyzer, with only minimal editing and configuration capability. An MMI can directly connect to all Ethernet-connected Maxum Analyzers. It also supports a subset of Advance Data Hiway panel messages.



Maxum Analyzer A Maxum Analyzer is a Syscon (System Controller) with: ! an MMI (Man-Machine Interface), ! SNEcons (Sensor-Near Electronics controllers), ! a Database, and ! software.



Method A method is the set of information needed to perform a component analysis on a stream. This includes instrument setup (detectors, valves, etc.), peaks/groups, data collection events, and integration events. Methods are developed in Advance EZChrom and exported to the database. They are transmitted to the SNEcon at the beginning of each cycle specified in the stream/method sequence.
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Monitoring interval A time setting, between 1 and 9 minutes, that specifies that the specific analyzer be checked more frequently than the default ten minute broadcast. The default is recommended except for short performance checks (when a new physical unit is added to the network). If the Monitoring interval is set to 0, it reverts to the default. A time interval above ten minutes should not be used, because, with broadcasts coming every ten minutes, it does not provide any information. The Monitoring Interval field is found on the Add unit to and the Unit Properties dialog boxes.



MMI See Man-Machine Interface.



NAU A NAU (Network Access Unit) is a Syscon (System Controller) ! without SNEcons (Sensor-Near Electronics controllers), ! with or without an MMI (Man-Machine Interface), ! with a Database, and ! with database and software.



Primary Key The Primary Key is unique identifier or set of identifiers in a record. Each table has at least one column designated as primary key. For ready identification, the primary key column(s) are gray. When more than one column is designated as primary, the full combination of information is considered a primary key. Multiple ampersands (&& or &&&) in the table header identify primary key combinations.



rarg real arguments



iarg integer arguments



Sequence A Sequence, called an Online Sequence in Advance EZChrom, is an ordered list of stream/Method pairs. Each application has at least a normal process sequence and a calibration sequence. Additional sequences are allowed. Only one sequence is active or being used. A running application has a current stream/method (the one that is in use by the SNEcon), a flowing stream/method (the one that will be sent next to the SNEcon unless a stream step
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occurs), and a step stream/method (the next flowing stream/method after a stream step). The Syscon controls the order that stream/methods are sent to the SNEcon, allowing manual control (see Sequence Control) from the MMI. A verification sequence is a special type that returns to the process sequence at the end.



Static View When the data from a database query is captured at the instant of the query and does not change, it is termed static. The table must be re-queried by some user action to see changes that may have occurred. Most of the system Manager table views are static. Static Mode is like a snapshot.



Status Bar The lowest part of the Advance System Manager screen is called the Status Bar, and extends horizontally across the bottom of the window. The default text on the left side of the bar is a reminder to press the F1 key for help. When the cursor moves across the various commands in the drop-down menus, a short description of the command function appears on the status bar. The right side of the status bar indicates whether the alpha characters are locked in upper case (CAP), whether the numeric key pad is in the number locked position (NUM), or whether the Scroll Lock has been pressed (SCRL).



Advance System Manager Status Bar



System View Window This is the lower section of the Advance System Manager window. It is identified by a tab labeled “All” and any custom group tabs you add after installation. To move the window around the screen, select the Float System View option from the View drop down menu. The same thing can be accomplished if you place the cursor on the System View window frame, click the right mouse button, and select the option from the drop-down menu. When the window is "floated," it behaves like a toolbar and can be placed within the window or elsewhere on the desktop. It can also be “docked” on either side, top or bottom of the window itself. When performing a maintenance task, the System View Window can also be hidden using the , but the window is generally in view for instant status review. Toggle System View button Icons on the window represent the analyzers and show their status. A "quick menu" is also available in this window using the right mouse button. Position the cursor on an analyzer icon and click the right mouse button to see a menu that includes the Update Unit command.
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Table Editor Toolbar When you move the cursor across a toolbar, Tool Tips, a popup label, indicates the function. At the same time, a more complete description is shown in the Status Bar. Note that when a function is not available, it is colored gray. Toolbars can also be moved and “floated” anywhere on the screen. Position the cursor on a blank area of the toolbar (not on a button), click and drag the toolbar across the screen to a different location. To restore it to the original position, double click the title bar. If you do not want to use this Toolbar, go to the View menu and select Table Editor Toolbar. The toolbar can be toggled "on" and "off" as it meets your needs



The Advance System Manager Table Editor Toolbar



Title Bar



The colored band at the top of any type of window including dialog boxes and detached toolbars is called a title bar. The title bar may, or may not, display the title of the window, but it will always include the Exit button used to close a window.



Tree View
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A hierarchical structure of objects in the database that appears in the left pane of the Analyzer window. The tree includes objects that are used to organize both Analyzer and application information.
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Appendix 1. Optichrom Comparison Charts Optichrom Comparison Chart One The tables in this Appendix compare Optichrom table entries to Advance Maxum table entries.
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Optichrom Comparison Table Two
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Optichrom Comparison Table Three
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Appendix 2. Table Examples Create Limits Create limits using SM[application][tables][limit][add record] :



Multiple Use of APPAI



The attributes shown above cause APPAI 3 for application 1 to be passed to any program for application 1 that runs for stream 30 which has a program with rarg that includes 2 (like '1.2.3' or '2'). The same item can be passed as an integer argument by placing the parameter_id in the iarg column. Use of a -1 in the streamcontext has a special meaning: use this parameter when no specific stream parameter has been defined.



means that parameter 2 for any stream uses AAPAI 3,
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this means that for stream 3, use APPAI 4 for parameter 2, but for all other streams use APPAI 3. There can be 10 real arguments(rarg0-rarg9) and 10 integer (iarg0-iarg9) arguments entered in this fashion. In addition, Four fixed integer arguments are also passed: application, stream, execution id, and alarm id. Another example (all are defined for the same application 5):



When program 50 runs for stream 3, the program is passed: integers (6,0) and reals (0.0, 6.14). These are referred to as iarg0, iarg1, rarg0, rarg1 in the Basic code. When program 60 runs for stream 4, the program is passed integers (3,4) and reals (1.0, 15.2). These are referred to as iarg0, iarg1, rarg0, rarg1 in the Basic code.



Standard I/O Setup Table The following is a table showing appxx ids and default settings for IO (detectors, temperature controllers, pressure controllers) that are created when app_detector, app_tempct, and app_pressctl are created in an application. Note that Advance Plus detectors that are manually configured will have different channels.
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Optichrom to Advance + I/O Mapping



I/O Cards on the backplane retain their original channel numbers. Their hardware ID can be obtained by following the convention shown below where S = Slot Num, T = Channel Type and C = Channel Number. Channel Types conform to Maxum standards.



Modbus Address Map The Modbus Address Map is a comma delimited ASCII text file that can be used with relational database packages (e.g. Microsoft Access or Ashton-Tate’s dBASE), spreadsheets (using Microsoft Excel, save as a .CSV file), or a text editor.
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The first line in the text file is a Header that contains labels for the columns in the Body of the file. The Body consists of all of the lines after the first line (delimited by a carriage return/line feed). Click here to view the Table of Address Mapping Fields. Each line in the Body contains these fields with commas separating the fields. The Maxum Modbus Address Map allows a host system to read and write some boolean, integer, and floating point values. Most of the values read are data from the analyzers. Some of the values read are generated by the Maxum Modbus interface. For example, the Maxum Modbus interface can set some booleans as “Read Me” flags that indicate that an analyzer has sent new values and reset these booleans after the host has read them. Values written by the Host, can control the operation of the analyzers. For instance, the Host might command that calibration be performed. For additional information about the Modbus Address Map, see: Emulating HCI-H Address Mapping and Duplicating HCI-H Configuration below



Emulating HCI-H Address Mapping The address map can be configured to emulate the address mapping of the HCI-H. The HCIH has 4878 booleans in Table 0 of which 200 where duplicates of other values (i.e. 4678 unique booleans). The HCI-H has 654 booleans in Table 1, used as “Read Me” flags. The HCI-H uses 5130 register locations in Table 3 and 8208 register locations in Table 4, with 900 of the Table 4 registers duplicating register values from Table 3. The HCI-H does not fully use the available Modbus address space Also, the Maxum Modbus map can be configured to emulate the effect of most of the built-in operations in HCI-H. The Rollover Table will be determined at configuration, not automatically during operation. To the Host system, the effect should be the same. See also, Modbus Address Map above.



Duplicating HCI-H Configuration The HCIH configuration can be duplicated, with the exception of the duplicate (redundant) data stored for stream 1. Where possible, all functionality has been duplicated. The application engineer will configure the address map according to customer requirements. The address mapping is no longer limited to placing certain data in specific addresses. The only requirements are that an address for the ANALYZERSTATUS is designated for all transmitting analyzer/applications and that each component is designated as a RESULT and EUHI if scaled or a RESULT if not scaled (data type R or Q). The other types are defined only as needed for the customer. This will greatly reduce the size of an address map and allow support for any number of analyzers and components, limited only by system resources. Larger address maps may significantly degrade the NAU’s database performance The value_type field will cause certain actions to be taken. These actions will include forwarding information to the analyzer and preparing information for reply to host read requests
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See also, Modbus Address Map above.



Table of Address Mapping Fields Location ID
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Appendix 3. Nomenclature Lists



Beginning with Version 3.1, inserting new addresses, deleting addresses, and modification of entries for an address are supported in both the Advance System Manager and the MMI.



Advance System Manager • 98



Location ID



Channel Number



Channel Type



Common Module Errors White = Notes
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Light Gray Text = Warnings Dark Gray Text = Errors
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Detector IO Map Formula and Table



DPM-FID Errors Light Gray Text = Warnings Dark Gray Text = Errors



DPM-TCD Errors Light Gray Text = Warnings Dark Gray Text = Errors
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DPM-TEMP Errors Light Gray Text = Warnings Dark Gray Text = Errors



FID-DPM Detector IO
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Module Type
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PECM



PECM Specific Errors Light Gray Text = Warnings Dark Gray Text = Errors
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SVCM



SVCM Specific Errors



TCD-DPM IO
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TCD-DPM/FID-DPM Temp Controller
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Summary of Changes in Version 3.1 Database Changes Modbus and Host communications 1. Dynamic add, delete, modify of Modbus map from System Manager and MMI 2. Rework of all Modbus communication, implementation of multi-drop for RS485 3. Added support for Modbus addresses in the 20000s and 70000s. Allow for swapped and unswapped IEEE floats. 4. Modbus block reads works for undefined addresses. 5. Advance Optichrom to Maxum Modbus interface supports transmission of results from an Optichrom to a Maxum Modbus NAU. 6. Send stream results to different hosts 7. HCI-C01 support for running verification sequence 8. Fixes: support for WRLP(9A) ADH message, null reference from delete of DO autotimer, overflow of printjob queue



I/O 1. Added ½ Isothermal oven tuning parameters. 2. Rework of all remote I/O access to use polling at 5, 10, or 15 sec. 3. Default for AI, DI polling is 15 sec, except for flame sense(1 sec.), Oven Temperature and PWM(5 sec.), and CAN(1 sec.) 4. Added DO for inverting detector signal, may be set for all peaks, or used as a cycle event for specific peaks. 5. Added temperature controller type for Siemens Liquid Injection Valve 6. Add optimized tuning parameters for full isothermal oven 7. Add parameters for methanator and FID block 8. Add capability to define all PID parameters for optimal operation of temperature controller with non-supported thermal load. 9. dynamic change for I/O units for temp/press controllers – change all I/O 10. Change name for detectors, temperature, and pressure controllers changes name on I/O
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MaxBasic and Programs 1. added ability to schedule verification sequence to run (pgmfunction = 2) 2. Post alarms and print custom reports from MaxBasic programs 3. much improved scheduling accuracy on program scheduling. Minimum 5 seconds frequency for scheduling. 4. Remove alarm for program running at end of cycle



Other 1. Advance Plus support 2. clean out of analyzer table based on time of last broadcast 3. fixed external results to saved_value in result table. Scanrate now like I/O (5, 10, 15 sec) default is 15 sec. 4. Print canned report from parameter table. 5. ODBC available



MMI Changes 1. Let DM start before DB 2. Let DM retry DB connections (DataNet especially) 3. New Screens: Method/Channel/Detail SETUP/limit, detail SETUP/Alarm Handler, detail SETUP/OTHER/ANLZ/DETAIL Results/External/ Detail 4. IO/*: list of possible IOs when modifying IOs 5. IO/*: add modify limit 6. IO/*: hide invalid input values 7. IO/CAN/DI,DO: add toggle invert option (on card) 8. IO/TC,PC,DETR/detail: show all sub-IO's & en/dis button 9. IO/DETR: add invert 10. SETUP/MODBUS: added add/delete/modify/OTHER 11. SETUP/MODBUS: add table of modbus map (first 500) 12. OP MODE - add ADD/DELETE applications
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13. Chroms(recent,archive,sim) add numeric zoom 14. MEAS/Real Time Trend: Plot "all" points, i.e., 10 points/sec but only update once a second 15. MEAS/Real Time Trend: update whatever is available (always caught up) 16. MEAS/Real Time Trend: Start of Cycle marker (optional) 17. SETUP/SYSTEM: #42 add button ICON option: 18. SETUP/SYSTEM: #43 add home page choice (RT, Menu, OPmode, Alarm) 19. SETUP/SYSTEM: #45 Separate TC display option for meas,opmode,... 20. SETUP/SYSTEM: #46 Move PC display option from 11 21. ALL: spinning ball for busy 22. DM/WS: option for full screen.



SNE OS Changes 1. Fixed bugs in network error handling 2. Further optimized I2C bus handling 3. Fixed bug for proper display of SNE hardware version 4. General speed optimization



SNE Application Changes 1. Support for Advance+ Adapter 2. Support for detector signal inverting 3. Virtual I/O allow analysis of Zero correction function 4. Ability to retrieve scaling data from new DPMs 5. Will not run methods when channel acquisitions from the same detector overlap 6. Allow 500 Hz sampling on a single detector channel 7. Balance simulation available on backplane balance DACs 8. Embedded EZChrom Update



System Manager Changes 1. Improved background processing, broadcast handling, data logging and memory handling major re-write of the architecture. 2.



Many bug fixes and small enhancements to interfaces in ASM and AU.
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3. Warning alarms for Maxum will be displayed in System View. However, it is by demand only the option needs to be enabled in Unit properties. 4. Local offline database option is available in Advance Utilities for load and unloads 5. Offline analyzers have a 'Save as' option available 6. Cascade sorting and sorting by date time is available in all the needed interfaces. 7. Alarm screen display improved - added new columns, sorting messages by time is enabled 8. Conservative prompt autosave option in table editor is available. By default, the records in a table get updated when the cursor is moved off the line. Now this feature can be disabled and the application prompts whenever the database is updated. 9. SNE upgrade mechanism enhanced - Checks for TFTP server and file before starting any loads. Implemeted a customized file size option in TFTP. 10. Advance Plus support is added. 11. Support for all previously released versions and cross compatibility. 12. Unload database was using a an incorrect version with 1.01 database - fixed 13. Load log file could not be viewed - used to show file error – fixed 14. When the default file extensions are not typed in, the file dialog boxes at various places do not add the extension – fixed 15. Sorting in IO tables is not consistent – fixed 16. IO dialog boxes come up sorted in the reverse order – fixed 17. Saving a offline analyzer during the application shutdown resulted in a crash/ not saving completely – fixed 18. NAU's can now be configured in Advance Utilities – fixed 19. List box in system view does not show the IP address completely - Now tool tips are enabled. 20. Invalid svdata file causing a crash – fixed 21. Winsock 2.1/OSR 2 problems in random units disabled. 22. in Windows 98, sorting of IP address does not work – fixed 23. Backup and Restore fails on some machines and has to be repeated for success fixed 24. Choice of hardware ID's restricted to valid options in App_temp_ctrl , app_press_ctrl and detector tables 25. Applications in System view are not in order after load/reloads – fixed 26. Maxum protocol had problems in handling the packet lengths – fixed
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EZChrom Changes New Known Problems since Advance EZChrom 1.2 a) When saving datafiles, the extension “.dat” is no longer appended. b) Peaks can be split only once. c) If peaks are generated graphically, and the peak/group table is never opened, results are calculated as zero. New features a) Added toolbar buttons to provide shortcuts for exporting and importing methods, chromatograms, and online sequences. b) All import and export dialogs are now “live” and respond to changes in the analyzer instantaneously. The lists can also be sorted by clicking on the different column headers. c) Supports FPD linearization via method custom parameter and a “misuse” of calibration level 10 for the linearization parameter. Both calibration and analysis work as usual. Linearization exponents can be calculated automatically from multi-level calibrations. Group linearization is not supported. d) When upgrading an installation of Advance EZChrom 1.2, an “Instrument Wizard” will pop up (this doesn’t occur for instruments created with Advance EZChrom 3.1). It is currently not recommended to use this wizard. Uncheck the box SHOW AT INSTRUMENT STARTUP at the bottom of this dialog and click OK to suppress this dialog in the future. e) Advance EZChrom can now use default user settings for all new instruments and supplies a standard settings file default.ust. f)



A new pressure unit, kg/cm2, is available.



g) All imported methods and online sequences are tagged with their origin. When attempting to export them to a different analyzer or application, a warning is issued. h) Methods can now be created from templates either globally for each instrument (default.met in the Advance EZChrom installation directory) or on a per instrument basis. i)



All detector setup data is now available on a single spreadsheet tab instead of having one tab for each detector.



j)



When entering invalid data in the instrument setup tabs, the user can now switch between tabs without having to correct invalid data. Upon closing the instrument setup, invalid data causes a list of problems to be displayed, and each error can be fixed by double-clicking on the error.



k) Groups can now display concentrations of their individual peaks in the chromatogram (see group definition in the group table). l)



For online sequences, a run type has been added that indicates whether a saved chromatogram should be used for calibration instead of running an actual cycle. The name for this run type is “Use saved stream chromatogram” (SAV). Support for this feature is not available in the database yet.



m) For calibration entries in online sequences, a flag “Print calibration report” can be set.
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n) Online sequence entries can now also be “Verification” or validation sequences. They behave just like a “Calibration and Process” sequences. o) Another property has been added to online sequences called “Stop at end” (previously available through the online sequence export dialog). This property is accessible as a checkbox via SEQUENCE | ONLINE SEQUENCE | PROPERTY and is disabled by default. p) Chromatogram scrolling is now available. You can now scroll around on a chromatogram view. In a zoomed chromatogram, hold the keys down while the mouse cursor is inside the chromatogram graph area, then click and drag. q) The Sequence/Summary report function has been removed. Its functions are replaced by the Advanced Reports feature. Existing sequence summary reports can still be used, however new summary reports must be generated using the Advanced Reports feature. r)



Concentration overrides have been added to the (reprocessing) sequence.



s) Data, Methods, Online Sequences, etc. can now be organized by projects. This feature is only available when also enabling users, groups, and security for Advance EZChrom instruments. t)



A number of menu entries can now be activated with accelerator keys in addition to the usual mouse operation.



EZC Fixes a) If a chromatogram window is closed, it appears to be gone. It can be resurrected without opening or re-importing data by choosing VIEW | TILE. b) Major rework of database driver to allow concurrent queries makes for more reliable connections and enables the application monitoring tool to be displayed simultaneously with the stream logging dialog. c) Extensive rework of the installing process. Advance EZChrom installations can now be ported from one computer to the next. Simply uninstall Advance EZChrom, then copy the contents of the directory to new directory on another computer, and install Advance EZChrom on the other computer in that directory. d) Multi-level calibration works properly in Advance EZChrom and in Maxum. e) In some cases, method files could be inadvertently overwritten because Advance EZChrom issued no warning that a method file already existed. This has been resolved. f)



With the Instrument Setup window open, importing or opening method files no longer cause Advance EZChrom to crash.



g) Occasionally when defining peaks for any channel with “Graphically define single peak” produced some strange results and attempts to locate peaks with retention time zero. This has been fixed. h) When importing a method with any of the Instrument Setup tabs open, Advance EZChrom now always adds a blank line at the bottom of the imported data. i)



Asymmetry calculations used to fail for certain peaks. This has been resolved.



j)



When a new online sequence is created, it now always defaults to “Calibration and Process” instead of assuming the settings of the previous online sequence.
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k) The small memory leak for chromatogram imports has been plugged. As a consequence, stream logging is no longer limited to approximately 5000 chromatograms. l)



The problem of unremovable ghost traces which appear with every chromatogram or missing traces is resolved.



m) Standard or custom reports with more than one page can now be viewed properly by using the vertical scrollbar. n) Repeated configuration with a large number of detectors, ovens, EPCs etc. is now possible without causing a crash. In addition, it is no longer possible to manually add modules from the available to the configured pane by double-clicking on them.
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